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* INSTALLARE, AVVIARE, AGGIORNARE, DISINSTALLARE

Che cosatroverete in questa sezione

In questa sezione troverete le risposte relative alle prime FAQ che l'utente affronta al
momento di installare Thunderbird (sia come prima installazione e sia come
aggiornamento) o di disinstallare il programma.
Non sono delle FAQ che indicano, nello specifico, “come si fa” passo per passo, (questa
non € una guida: vi sono ottime guide in italiano su Thunderbird, e nelle stesse FAQ sono
indicate dove scaricarle) ma delle risposte ai dubbi piu comuni.
Noterete una scarsa informazione riguardante I'esportazione da Thunderbird a Microsoft
Outlook / Outlook Express; i motivi sono vari:
o questo e un aspetto che va bene approfondito nel Forum di Mozilla Italia, dove
esistono numerosi e “corposi” argomenti al riguardo;
o il nostro augurio € che non avrete mai bisogno di eliminare Thunderbird per tornare
ad Outlook...
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Outlook Express: no. Thunderbird: si. Perché?

Problema

Questa non e forse la FAQ piu frequente, ma sorge spontaneo domandarsi — prima di ogni
altra cosa — perché non utilizzare Outlook Express, il comodo programma fornito gia da
Microsoft Windows, per gestire la posta elettronica.

E un dato di fatto che Outlook Express, il client e-mail pit diffuso, & anche uno dei
programmi meno sicuri per gestire la posta tramite Internet, poiché la sua stretta relazione
con Internet Explorer (e quindi con tutto il Sistema Operativo) lo rendono vulnerabile.

Ma perché, allora, € meglio scegliere Thunderbird e non un altro programma di posta
elettronica?

Soluzione

Provate a confrontare un altro client e-mail con Thunderbird:

1. Thunderbird e sicuro. Anche senza le apposite estensioni riguardanti la sicurezza,
Thunderbird & un client e-mail che non da sgradite sorprese a chi lo utilizza per
gestire la posta da Internet (non consente di default I'esecuzione di Javascript, ha
un comodo e accessibile convertitore da HTML a formato Testo puro — PlainText —
che riduce a zero il rischio di problemi dovuti all'esecuzione di eventuale codice
maligno inserito in una e-mail, e fornito di serie di un efficacissimo filtro antispam di
tipo bayesiano che puo arrivare a identificare il 99% dei messaggi indesiderati, puo
rendere impossibile agli spammer che possano vedere se il vostro indirizzo email
esiste veramente, poiché puo impedire il caricamento delle immagini remote
allegate nel messaggio di SPAM — trucco usato molto frequentemente —, possiede
avanzate caratteristiche anti-phishing, ed avanzate opzioni di sicurezza, etc.).

2. Thunderbird e gratis. Anzi, & open source. Anche senza spiegare questi termini,
significa che vi basta soltanto scaricarlo da Internet per iniziare ad utilizzarlo, senza
pagare nulla a nessuno, in perfetta legalita!

3. Thunderbird € in italiano. Il programma e disponibile in italiano (oppure in inglese,
ma con il language pack italiano).

Anche la sua guida € in italiano.

Anche le sue estensioni sono in italiano (fare riferimento a www.extenzilla.orq).
Anche il suo sito web ¢ in italiano (http://www.mozilla-
europe.org/it/products/thunderbird/ ).

Anche il Forum per 'assistenza ¢ in italiano
(http://forum.mozillaitalia.org/viewforum.php?f=3 ).

4. Thunderbird e personalizzabile. Secondo le proprie esigenze funzionali o
estetiche, é possibile utilizzare i Temi o le Estensioni.

5. Thunderbird é facile da utilizzare. La sua interfaccia &€ gradevole ed intuitiva (oltre
che, come abbiamo gia letto, personalizzabile).

6. Thunderbird é aggiornatissimo. Thunderbird possiede alcune caratteristiche che
tanti client e-mail non hanno (supporto feed RSS, funzionalita avanzate e
personalizzabili di ricerca dei messaggi, etc.). Thunderbird, in nome della sicurezza,
viene aggiornato spesso (non prendete questi aggiornamenti frequenti come
insicurezza del programma, ma anzi accettateli come pronta risoluzione alla
scoperta dei bug. Thunderbird & un prodotto del’'uomo e, come tale, non é perfetto.
Ci preoccuperemmo davvero se lo fosse!).

7. Thunderbird é adattabile. Thunderbird & multipiattaforma, ne esistono versioni per
Windows ma anche per altri sistemi operativi.
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Thunderbird e disponibile in versioni che si installano tramite archivio.zip (a richiesta
sul Forum di Mozilla Italia, in attesa del lancio ufficiale).

Thunderbird e disponibile in versione MegaPack (una versione del programma in
italiano comprensiva di una raccolta di estensioni, temi e guide), creata da
emformer, scaricabile da questo indirizzo:

http://iacchi.altervista.org/Thunderbird 1.0.2 mega-pack.zip

Ma, soprattutto, € disponibile in versione portatile su chiave USB
(http://www.mozillaitalia.org/mozup/index.php) : una comodita enorme!

8. Thunderbird ha un’assistenza tecnica eccezionale. Il Forum di Mozilla Italia si
distingue per la passione, la competenza, la velocita, la precisione dei suoi utenti,
tutti pronti a dare una mano (gratis!) a chi si trova in difficolta con i prodotti Mozilla.
Del resto, i numeri lo confermano: controllate quanti sono gli utenti di questo Forum
ed i messaggi rilasciati, qui: http:/forum.mozillaitalia.org/index.php .

Domanda: il client e-mail che avevate scelto per il confronto ha tutte queste
caratteristiche?

Commento

In caso di ulteriori dubbi, contattate il Forum di Mozilla Italia oppure inserite la vostra FAQ
in un motore di ricerca.
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Scaricare Thunderbird: da dove?

Problema

Dove posso scaricare Thunderbird?

Soluzione

Da questo link: http://www.mozillaitalia.it/archive/index.html#p2 .

Commento

Controllate spesso il link suddetto per aggiornare il programma ed averlo sempre piu
efficiente.
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Creare un account: come?

Problema

Non si sa come creare un account.

Soluzione
1. Dopo aver aperto Mozilla Thunderbird, effettuare le seguenti operazioni per
aggiungere un account di posta elettronica completo di SMTP proprio (quindi non &
piu necessario appoggiarsi all'SMTP principale).
2. Selezionando "Cartelle Locali", andiamo su "Crea un nuovo account” ed iniziamo la
procedura per questo nuovo inserimento.

Mozilla Thunderbird Posta - Cartelle locali

Account

@ Yisualizza impostazioni per guesto account

€ Crea un nuovo accn%

3. Selezioniamo ovviamente "Account di posta" e procediamo.

() Account gruppi di discussione

4. Inseriamo i dati richiesti:
Il nome che deve comparire al destinatario della mail quando gli inviamo della posta
(in questo caso "Mario Rossi")
L'indirizzo e-mail completo dal quale, e per il quale, devono partire/arrivare le e-

ma|| | Creazione nuovo account L

Identita

0gni account ha una propria identitd, cioé linsieme di informazioni
che permettono a chi riceve il messaggio di identificarne il mitkente,

Inserire il nome che apparira nel campo "Da:" dei propri messagagi in
uscita (ad esempio, "Mario Rossi").

Horne: |Mari0 Rossi |

Inserire il proprio indirizzo email. Questo & lindirizzo che gli alkri
utilizzeranno per spedirci messagai di posta elettronica {ad esempio,
“Uutente@esempio,net").

Indirizzo email: |mari0@rossi.itl |

[<Indietr0] [ Avanti = ] ’ annulla ]
]
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5. Scegliamo un server POP3 (potete benissimo inserire 'IMAP, non cambia nulla) e
inseriamo quindi l'indirizzo di tale server. Nell'esempio "pop3.rossi.it".

pnpS.rnssi.itI '

..l. _
i L _,.4-".---

6. Sia come nome utente in entraﬁi e in uscita, inseriamo l'indirizzo completo di
posta elettronica, cosi da non avere problemi all'atto dell'autenticazione con il :
server. Nell'esempio "mario@ro nltI viene dato in entrambi i campi.

mario@rassi.it

mariu:u@ru:ussi.itl

7. Nel "Nome account” ancora una volta confermiamo il nostro indirizzo completo di
posta elettronica.

marioi@rossi. it
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8. Una volta completata la procedura, possiamo scaricare i messaggi che sono
presenti sul server. Spuntiamo quindi I'opzione "Scarica subito i messaggi" e
confermiamo. Quando sta per avere inizio il download della posta, inseriamo la
nostra password d’accesso al server e confermiamo. Dopo qualche secondo/minuto
la nostra posta sara pronta da leggere direttamente sul nostro PC. Procediamo
facendo clic su "Fine".

Mome server in uscika (SMTPY:  smiktp,gxware.org

a Scarica subito | messaggi
Premere Fine per salvare gueste imposkazioni ed uscire

dcllcs dbc cocoo oo dolllc coooasl

{Indietrnl l Fine 4
L

9. Da Opzioni - Impostazioni account, partira la nostra procedura per l'inserimento
del server SMTP apposito per il nostro nuovo account di posta elettronica.

Skrumenti #

Eskensioni
Temi

Filtri...

Controlli posta indesiderata. ..

Irmporka...
Javascript Console

zioni account. ..
Opzioni. .. k

10. Dalla lista che abbiamo sulla sinistra della finestra che ci compare, scorriamo in
basso fino a vedere I'opzione "Server in uscita (SMTP)" e selezioniamola. Si aprira
cosi sulla destra della finestra, la pagina dedicata ai server SMTP che abbiamo
configurato nel programma.

¥

rddried 2 spasl Sl

Server in uscita (SMTR)

l Aggiungi account. .,
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11.In questa scheda sara possibile vedere il server SMTP configurato come predefinito

dal programma. Per gestire i server o aggiungerne di nuovi facciamo clic su
"Avanzate".

E necessario specificare un solo server (SMTP) in uscita, anche se si possiedono alkri account di
posta, Inserire il nome del server per la poska in uscita,

Home server: | EEG—S

= TR
|| Ukilizza nome utente & password

Itilizza connessione sicura (S5LY):

| Porta: Predefinito: 25

) Mai ) TLS, se disponibile ) TLS () SAL

Avanzate, .,

4,

12.Selezioniamo ora "Aggiungi..." per inserire il nostro nuovo server di posta in uscita

Impostazioni avanzate server in uscita (SMTP) ®|

Monostante sia possibile specificare pit di un server in uscika
[SMTPY, questa impaostazione & consigliata solo ad ukenki
esperti, Tale impostazione pud causare errori durante linvio

della posta,

I = (Predefinito) dagiungi..
I 75

[ s

I <65

|

I 75

(0]4 ] [ Annulla

13.Inseriamo i dati relativi al nuovo server! Nell'esempio abbiamo scelto smtp.rossi.it e
la porta 25 (al 99% dei casi quella che viene usata per la posta in uscita sulla

maggior parte dei server, controllate comungue quello che dice il vostro provider nel
contratto o in qualche eventuale altra comunicazione).

| Server SMTP @

Mome: server: |smtp.rossi.it | Porta: [z5 | Predsfinito: 25

0 Kl 1
| Utiizza nome utente & passward,

Utilizza connessione sicura (S5L):

() Mai ) TLS, se disponibile () TLS |

& () 551
[ OKL\\§J [ Annulla ]
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14.Una volta aggiunto il server SMTP, comparira nella nostra lista e sara quindi
possibile assegnarlo all'account mario@rossi.it (che abbiamo precedentemente
creato). Conferma il tutto con OK ed esci fino ad arrivare alla schermata principale

di Thunderbird.

Impostazioni avanzate server in uscita (SMTP) @

Monaostante sia possibile specificare pitl di un server inuscika
(SMTF), questa impostazione & consigliata solo ad utenti
esperti, Tale impostazione pud causare errori durante linvio
della posta,

I - - & | aggiungi...
[ [
| EBES Modifica. ..
[ |

I -~

¢ srnkp, rossi k25

Elimina

v Predefinito

11}

e

[ (0]4 ] [ Annulla

15. Ritornando in “Opzioni = Impostazioni account”, scorriamo la lista fino ad arrivare
al nostro account (mario@rossi.it) e dalla sua scheda "Impostazioni Server"
scegliamo "Avanzate".

=1 marici@rossi, it

i~ Impostazioni server

E---Cartelle & Copie
é---Cl:ump-:usizil:une e indiriz. ..
é---SpaziD su disco
E---Ricevute di ritorno
-Sicurezza

'-| Iméastazioni Server

[ | Usa cannessione cripkata (S5L)

|| Usa autenticazione criptata

|| Controlla nuovi messaggi all'awwio

™ Controlla nuovi messagai ogni ririki
f_‘,' Scarica aukomaticamente nuovi messaggi

|| Lascia i messaggi sul server

] ]

|| Swuata Cesting alluscita

Impostazioni avanzate per l'account @

16.Dalla lista dei server SMTP
configurati, scegliamo smtp.rossi.it
(precedentemente creato) e
confermiamo il tutto con OK.
Abbiamo cosi creato il nostro
account completo di server di posta
in entrata e in uscita,
completamente autonomo e pronto
per essere utilizzato.

Per spedire messaggi da questo profila usa
sempre il sequente server di posta in uscita
[SMTRY:

SErver:

| ok g[ annulla |
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Commento

Grazie a Gioxx per questa FAQ.
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Scaricare automaticamente la posta all’avvio di Thunderbird,

come?

Problema

Si vuole scaricare la posta automaticamente all'avvio di Thunderbird.

Soluzione

Questa procedura deve essere ripetuta automaticamente per ogni account.

1. Andare nel menu “Strumenti (Modifica) = Impostazione Account...”
2. Seleziona I'account ed accedere al pannello Impostazioni Server; in questo
pannello € necessario spuntare le voci:

o Controlla nuovi messaggi all'avvio: non scarica automaticamente i
messaggi, si limita a verificarne la presenza sul server e notificarlo all'utente

o Scarica automaticamente nuovi messaggi: questa opzione scarica anche
i messaggi dal server.

Impostazioni Server

Tipo di Server: Server posta POP
Mome Server: Porta: 110 Predefinito: 110

MNome utente:

Impostazioni Server

Usa connessione criptata (S5L)

Usa autenticazione criptata

| ¥ Controlla nuovi messaggi all'avvio

¥ Controlla nuowvi messaggi ogni |10 minuti

| ¥ Scarica automaticamente nuovi messaggi

Preleva soltanto le intestazioni

Commento

Grazie a flod per questa FAQ.
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Aggiornato Thunderbird: cosa fare se dopo non funziona?

Problema

Dopo I'aggiornamento, Thunderbird non funziona.
E una delle FAQ piu frequenti.

Soluzione

Puo succedere che, dopo l'aggiornamento ad una nuova versione, Thunderbird non riesca
ad awvviarsi:
o inalcuni casi il processo e presente nell'elenco dei processi del Task Manager ma
non viene visualizzata nessuna finestra,
o in altri casi il programma si avvia mostrando schermate di errore (scritte rosse su
fondo giallo) o mostra solo finestre parziali

Il problema € dovuto al profilo in uso, per questo esistono due soluzioni:

1. la creazione di un nuovo profilo, come spiegato in questa FAQ
2. la pulizia del profilo con eliminazione di temi ed estensioni

1. Creazione nuovo profilo

Una volta creato il nuovo profilo, come da questa FAQ, bisogna procedere alla
riconfigurazione degli account e-mail.

Dopo aver riconfigurato gli account, per copiare le mail dal vecchio profilo e sufficiente
copiare il contenuto della cartella MAIL dalla cartella del vecchio profilo all'interno del
nuovo.

| file della rubrica hanno estensione .mab: il file della rubrica principale € normalmente
chiamato abook.mab.

In alcuni casi, potrebbe essere necessario cancellare all'interno di queste cartelle i file con
estensione .msf. Si tratta di file di indice, che vengono automaticamente ricreati alla
riapertura di Thunderbird

2. Pulizia del profilo esistente
Per eliminare i temi e le estensioni, procedere in questo modo:

o fare una backup della cartella del profilo (copiandola o, se proprio si vuole, usando
software come Mozilla Backup, che perd non € molto affidabile). Per individuare la
cartella del profilo seguire queste indicazioni.

o all'interno della cartella del profilo, con Thunderbird chiuso, eliminare le cartelle
CHROME ed EXTENSIONS.

In questo modo si perderanno tutte le estensioni ed i temi, ma il programma dovrebbe
ritornare a funzionare e tutte le impostazioni esistenti verranno mantenute.
Personalmente, riteniamo buona norma fare questa procedura in ogni caso, prima di
aggiornare Thunderbird ad una nuova versione.

Commento

Grazie a flod per questa FAQ.
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Importare le e-mail e la rubrica da Outlook: come fare?

Problema

Come importare i messaggi ed i contatti da Outlook / Outlook Express / Eudora o altri
programmi?
E una delle FAQ piu frequenti.

Soluzione

Premessa: qualunque importazione tra Outlook / Outlook Express e Thunderbird non potra
mai essere perfetta, poiché entrano in campo numerosissime variabili (formati non
standard di alcune mail inviate o ricevute, caratteristiche degli allegati o dei link acclusi
nelle e-mail, messaggi aggiunti dall’antivirus al corpo delle e-mail, etc.) tra le quali
spiccano proprio i formati “chiusi” dei programmi Microsoft, che ovviamente non
favoriscono (volutamente!) la trasmigrazione dei dati.

Vista I'importanza della posta elettronica, questo problema dovrebbe fare riflettere: vi va
bene che tutti i vostri messaggi siano ben leggibili solo in un formato proprietario
(.dbx) di Outlook / Outlook Express e che tale formato vi costringa a rimanere fedeli
per tutta la vita alle future versioni di Outlook per essere letto?

In ogni caso, torniamo alla FAQ.
Se non avete gia importato i contatti e le e-mail durante I'installazione di Thunderbird,
potete farlo adesso.

Rubrica: da Outlook Express a Thunderbird

1. Awviare Thunderbird;

2. Fare clic su “Strumenti” e poi su “Importa...”;

3. Per importare i contatti, a fianco del tipo di oggetto da importare, mettere il pallino
su “Rubrica’”;

4. Fare clic su “Avanti”;

5. Selezionare il programma dal quale vorrete importare gli indirizzi (esempio:
“Outlook Express”) e fare clic su “Avanti” per iniziare I'importazione vera e propria;

6. Al termine, fare clic su “Finito”.

7. Attenzione:

- Thunderbird importa tutti i contatti di tutte le identita presenti in Outlook Express;
- | nomi vengono memorizzati nella sottorubrica Rubrica di Outlook Express;
- Non vengono mai salvate le e-malil alternative.

Rubrica: da Thunderbird a Outlook Express

1. Awvviare Thunderbird,;

2. Fare clic su “Strumenti” e poi su “Rubrica”;

3. Scegliere “Strumenti”, poi “Esporta” e salvare il file con il formato LDIF;

4. Avviare la rubrica di Outlook Express: “Strumenti”, “Rubrica” e scegliere “File”, poi
“Importa” ed infine “Altra rubrica”;

5. Fare clic su “Formato interscambio dati LDIF-LDAP”, poi premere il pulsante

“Importa” e selezionare il file salvato in precedenza.
6. Terminato il processo, la rubrica di Outlook Express conterra i contatti importati da
TB.
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7. Attenzione: Il processo funziona correttamente anche con i gruppi, con l'unico
difetto che non vengono importate le e-mail alternative degli utenti.

Messaggi: da Outlook Express a Thunderbird

1. Awvviare Thunderbird,;

2. Fare clic su “Strumenti” e poi su “Importa...”;

3. Per importare i messaggi, a fianco del tipo di oggetto da importare, mettere il pallino
su “Posta”;

4. Fare clic su “Avanti”;

5. Selezionare il programma dal quale vorrete importare la posta (“Outlook Express”)

e fare clic su “Avanti” per iniziare I'importazione vera e propria,;

Al termine, fare clic su “Finito”;

Le cartelle importate da Outlook Express si troveranno sotto la voce “Cartelle

locali”, nella cartella “Outlook Express Posta”. Aprendola, ci saranno le sotto-

cartelle contenenti le e-mail, ad esempio “Bozze”, “Posta eliminata”, “Posta in
arrivo”, “Posta in uscita”, “Posta inviata”.

8. A questo punto potrete spostare i messaggi semplicemente selezionandoli e
trascinandoli nella cartella desiderata.

9. Attenzione: Thunderbird importa solo i messaggi dell'identita "principale” di Outlook
Express (attenzione a non confondere, in Outlook Express, le identita con gl
account). Se avete una sola identita non ci sono problemi, ma se ne avete
impostata piu di una, prima di compiere l'importazione dei messaggi in TB dovete
verifica-re il settaggio di Outlook Express;

10. Per farlo: avviare Outlook Express, se compare la schermata di scelta dell'utente
fare clic subito su “Gestisci identita”, altrimenti all'apertura della finestra del
programma scegliere “File”, “Cambia identita” e poi “Gestisci identita”. Sull'ultima
casella in basso, va adesso selezionata l'identita da cui poi vogliamo importare i
messaggi verso Thunderbird.

11.Volendo trasferire in Thunderbird i messaggi di tutte le identita di Outlook Express,
bisognera rifare il processo di importazione per ogni identita, modificando di volta in
volta la casella appena vista.

No

Messaggi: da Thunderbird a Outlook Express

Per trasferire i messaggi da Thunderbird a Outlook Express bisogna utilizzare un

software di terze parti, poiché non esiste modo per effettuare un passaggio diretto. Per

I'operazione consigliamo di usare IMAPSize, un programma freeware usato per gestire

efficacemente lo spazio delle cartelle IMAP e di cui sfrutteremo solo il comando

"mbox2eml".

Il link per il download é http://www.broobles.com/imapsize/download.php .

Il link delle istruzioni (in inglese) e http://www.broobles.com/imapsize/th2outlook.php .

1. All'avvio di IMAPSize, dopo l'installazione, scegliere pure di non creare alcun
account;

2. Fare clic su “Tools”, poi su “mbox2eml|” e vedrete aprirsi una finestra di dialogo;

3. In corrispondenza della prima casella a discesa, fare clic sui puntini, impostare “All
files (*)” come “Tipo file” e quindi selezionare la cartella dove sono stati memorizzati
i messaggi di Thunderbird.

4. La cartella in questione puo essere individuata avviando Thunderbird, facendo clic
su “Strumenti”, poi “Impostazioni account” e quindi su “Impostazioni Server”

Pagina 17 di 112


http://www.broobles.com/imapsize/download.php
http://www.broobles.com/imapsize/th2outlook.php

dell'account di cui si vogliano trasferire i messaggi: in basso vedrete il percorso
della cartella cercata;

5. Torniamo a IMAPSize: selezionata la cartella voluta, vedrete una serie di nomi di
file che coincidono con le cartelle dell'account scelto di Thunderbird;

6. Scegliere un file (uno di quelli senza estensione) e fare clic su “Apri” per tornare alla
finestra precedente;

7. Adesso sulla seconda casella a discesa indicare una cartella di destinazione (il
suggerimento e di crearne una da cancellare a lavoro terminato, ad esempio
D:\prova), quindi fare clic su “Add conversion table”;

8. Ripetere 'operazione per tutte le cartelle che interessano, quindi fare clic su
“Convert”. In questo modo si avvia l'operazione di trasformazione di tutti i messaggi
di Thunderbird in file .eml, i quali vengono salvati nella cartella da noi indicata;

9. Terminata l'operazione, chiudere IMAPSize e aprire Outlook Express.

10.Per completare il lavoro, avviare Esplora Risorse e posizionarsi sulla cartella con i
file appena creati;

11. Selezionarli tutti e, trascinandoli col drag-and-drop, portarli in una cartella di Outlook
Express;

12.1l gioco é fatto; a questo punto si puo anche cancellare la cartella temporanea
creata e disinstallare IMAPSize.

Messaggi e Rubrica: da altri programmi

Se si hanno differenti client e-mail non inclusi nella lista di Thunderbird, & possibile
importare comunque quanto desiderato in Thunderbird stesso, con uno dei seguenti
procedimenti:

1. Se il programma di posta originario salva le e-mail in formato “mbox” le e-mail,
allora non c’é nessun problema, poiché anche Thunderbird salva i messaggi in tale
formato;

2. In caso di altri formati di posta, allora utilizzate un programma che vi consenta
prima di convertire tale formato in messaggi per Outlook / Outlook Express /
Eudora, poi le e-mail ottenute le convertite secondo quanto riportato nei
procedimenti precedenti;

3. In caso di altri formati di posta, nel caso il procedimento precedente non fosse
soddisfacente, cercate su Internet dei programmi che consentono la conversione
tra il programma di posta originario e Thunderbird (ad esempio, per le email c’e
Aid4Mail — pero a pagamento — che converte parecchi formati oppure dei
programmi specifici come IncrediConverter per Incredimail, mentre per la rubrica
c’e Dawn, che converte le rubriche da e verso una pletora di formati; la cosa
comoda e che riconosce l'istallazione e tutti i profili di Thunderbird disponibili,
aprendo direttamente I'address book ).

Commento

Sul MozillaZine c’e un’apposita sezione con le risoluzioni per i problemi di conversione:
http://kb.mozillazine.org/Category:Migration_(mail)

Grazie a gialloporpora per questa FAQ.
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e Pack: come installarlo?

Come si installa il language pack in Firefox e Thunderbird?

Soluzione

In tutti i sistemi operativi & necessario installare il langpack nel browser, direttamente via
web oppure tramite il pacchetto scaricato in locale.

Nel primo caso é sufficiente recarsi nella pagina di download di Mozilla Italia e fare clic
sul link del langpack: si dovra attendere il download e poi confermarne l'installazione.

Nel secondo caso, obbligatorio per Thunderbird, si deve fare clic col tasto destro sul link,
e scegliere I'opzione per salvarlo localmente. Il langpack va quindi installato in Firefox
aprendolo direttamente dal menu “File > Open*, in Thunderbird dal menu “Tools >
Options - Extensions - Install new extension®.

Al termine dell'operazione, con qualunque dei due metodi, € necessario chiudere e
riavviare il programma e procedere come descritto di seguito secondo il sistema operativo
utilizzato.

Windows
Per Windows si deve avviare Firefox (o Thunderbird) con le opzioni

-UlLocale it-IT -contentLocale IT.

Il modo piu semplice per fare cio & di modificare una delle icone con cui si avvia
abitualmente il programma.

Selezionare ad esempio l'icona sul desktop.
Fare clic col tasto destro sull'icona e scegliere la voce Proprieta.
Al termine del campo Destinazione: aggiungere uno spazio e la stringa

-UlLocale it-IT -contentLocale IT

La stringa risultante deve essere simile a questa:
C:Programmi\Mozilla Firefox\firefox.exe" -UlLocale it-IT -contentLocale IT

Confermare il valore inserito con il pulsante OK e avviare il programma con l'icona
modificata.
A questo punto il programma dovrebbe essere in italiano.

Linux

Per Linux dopo l'installazione del language pack (che deve essere eseguita da utente
root), si deve chiudere il programma e aprire una finestra terminale, quindi posizionarsi
nella directory di installazione del programma (ad esempio con il comando cd /opt/firefox/
o cd /opt/thunderbird/) e lanciare il comando

per Firefox
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ffirefox -UlLocale it-IT -contentLocale IT
per Thunderbird
/thunderbird -UlLocale it-IT -contentLocale IT .

Ogni utente dovra ri-eseguire la procedura d’avvio per avere il programma in italiano.

Mac OS X
Per Mac OS X dopo l'installazione del language pack si deve chiudere il programma,
aprire una finestra terminale e lanciare uno di questi comandi:

Firefox
/Applications/Firefox.app/Contents/MacOS/firefox-bin -UlLocale it-IT -contentLocale IT

Thunderbird
/Applications/Thunderbird.app/Contents/MacOS/thunderbird-bin -UlLocale it-IT -
contentLocale IT

In OS X il language pack non traduce totalmente l'interfaccia: una parte dei menu rimane
in inglese.

Per completare la traduzione e necessario copiare i file contenuti nel pacchetto
Italian.lproj.zip nella posizione Contents/Resources/Italian.lproj.

Commento

Grazie a dalco per questa FAQ.
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Disinstallare Thunderbird: come?

Problema

Come si disinstalla Thunderbird?

Soluzione
Se la versione di Thunderbird & quella con lo .zip, basta cancellare la cartella nella quale e
posizionato il programma: questa versione non crea collegamenti da nessun’altra parte e

quindi la rimozione & semplicissima!

Se la versione di Thunderbird & quella con l'installer (la piu utilizzata), procedere come si
fa con qualsiasi altra applicazione di Windows:

“Start - Impostazioni - Pannello di Controllo - Installazione applicazioni”.
All'interno, selezionate il programma “Thunderbird” dall’elenco.

Fate clic sul tasto “Cambia/Rimuovi”.

Compare una richiesta che ci avverte se siamo sicuri di volere disinstallare
Thunderbird: rispondere di si.

5. E tutto: ora il programma & stato disinstallato.

Pwn R

Commento

In caso di ulteriori dubbi, contattate il Forum di Mozilla Italia oppure inserite la vostra FAQ
in un motore di ricerca.
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« ALLEGATI

Che cosatroverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ di come gestire gli allegati di posta
elettronica.

Ci sono molteplici aspetti della loro gestione che, dato il numero considerevole,
ovviamente non possono essere tutti trattati qui.

Il nostro consiglio, pertanto, & sempre lo stesso: collegatevi al Forum di Mozilla Italia e —
con la funzione di Cerca nel Forum - consultate i numerosi argomenti al riguardo.

Moti dubbi, inoltre, possono essere risolti facilmente cercando le estensioni relative proprio
alla gestione degli allegati (c’é una lista sul Forum di Mozilla Italia e comunque consultate
sempre il sito specializzato http://www.extenzilla.org/).
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Allegati: come comportarsi?

Problema

Come bisogna comportarsi al ricevimento di un allegato di posta elettronica?

Soluzione

Come ci si dovrebbe comportare con qualunque programma di posta elettronica, non solo
con Thunderbird!

o In Thunderbird, fare un doppio clic sull’allegato e scegliere sempre la voce “Salva
su disco” (eliminarlo senza indugi, invece, se si tratta palesemente di un virus, ad
esempio il mittente e straniero e sconosciuto oppure l'oggetto contiene le classiche
parole-trappola Hi, Important message for You, Sex pictures, Viagra, Microsoft
Office only $ 50, etc.).

o Una volta salvato, scegliere la cartella che contiene l'allegato e scansionarla con un
antivirus aggiornato.

o Non utilizzate mai I'opzione “Da ora in avanti esegui questa operazione per tutti i
file come questo”: si presta ad abusi che possono compromettere la vostra
sicurezza! E piu prudente la gestione manuale di ogni singolo allegato!

o Anche se non li salvate come descritto in precedenza, ricordate che gli allegati
scaricati vengono memorizzati nell’archivio di posta, assieme al messaggio
corrispondente. Se volete eliminare un allegato dall’archivio, dovete solo eliminare il
messaggio corrispondente (se avete una versione precedente a Thunderbird 1.5)
oppure (se avete la versione di Thunderbird 1.5 o successiva) € possibile eliminare
uno o piu allegati dal messaggio e lasciare il testo integro.

Commento

Grazie a Paolo Attivissimo (www.attivissimo.net ) per questa FAQ.
Per la vostra sicurezza, vi consigliamo di leggere il suo libro, davvero ben fatto e semplice:
“L’acchiappavirus”.
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Allegati: impossibili da aprire?

Problema

Accade che Thunderbird provi ad aprire direttamente un allegato (ad esempio, con
estensione .doc) ma non ci riesca!
E possibile salvare, eliminare, etc. I'allegato ma non aprirlo direttamente.

Si puo utilizzare questo trucco:

- andare nel menu “Strumenti - Opzioni - Allegati”

- nella sezione "Tipi file" rimuovere I'associazione ai file .doc

- poi aprire una mail con un allegato in .doc

- farci doppio clic: Thunderbird vi chiedera cosa fare e voi rifarete I'associazione.

Ma, poi, potrebbe ugualmente accadere che Thunderbird non apri il formato allegato.

Soluzione

o Chiudere Thunderbird

o Trovare, tramite il "Cerca" di Windows, il file mimetypes.rdf (questo file e dentro la
cartella del profilo, pertanto se si utilizza la funzione "Cerca" prestare attenzione
poiché se si hanno piu profili, si rischia di fare ancora piu confusione).

o Rinominarlo, sempre a Thunderbird chiuso, in mimetypes_OLD.rdf

o Riavviare Thunderbird: ora dovrebbe essere possibile aprire il formato specifico
dell'allegato.

Commento

In sintesi, si tratta della corruzione del file mimetypes.rdf.
Si potrebbe anche provare a cancellare, a Thunderbird chiuso, il file XUL.mfl, che sta
dentro il profilo, poi riavviare il programma.
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Allegati: impossibili da inviare?

Problema

Accade, con il timeout di connessione a 60 secondi (di default) che la barra di
progressione di invio degli allegati di grandi dimensioni, procede abbastanza velocemente
ma poi si arresta alla fine, mentre il router continua a inviare dati.

Trascorsi i 60 secondi di timeout, compare un messaggio di errore del server smtp
(“Impossibile inviare il messaggio”).

La soluzione del problema sta nell'aumentare indefinitamente il tempo di timeout, in modo
che Thunderbird attendera pazientemente che l'invio sia completo, senza far apparire il
messaggio di errore di cui sopra.

Soluzione

1. Aprire Thunderbird.

2. Modificare il tempo da “Strumenti - Opzioni - Avanzate - Scheda Generali >
Timeout connessione”

3. Inserire un qualsiasi valore superiore a 60, ad esempio 99999.

4. Per scrupolo, si puo anche verificare dall'editor di configurazione (“Strumenti >
Opzioni > Avanzate - scheda Generali > pulsante Editor di configurazione”) che
il valore e cambiato anche li, alla voce mailnews.tcptimeout.

Commento

Grazie ad Eroe per questa FAQ.
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Allegati: non incorporati nel messaggio?

Problema

Se si inviano file html e css a persone che utilizzano un altro client di posta elettronica,
molto probabilmente tali file arriveranno loro all'interno del testo della mail, mentre - ad
esempio - con Outook il destinatario ha la possibilita di aprire I'allegato.

La cosa scomoda e che io destinatario non riesce a salvarsi l'allegato, ma deve copiare ed
incollare dal testo della mail.

Soluzione

Provare a mettere questa riga in user.js, all'interno del profilo:
user_pref("mail.content_disposition_type", 1);

Commento

Tale riga fara si che gli allegati siano mandati tutti con l'opzione "Content-

Disposition=attachment" anziché "inline" (che in TB & il default), e il problema sara risolto:
il destinatario finalmente vedra l'allegato "staccato" dal testo della mail.
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e CARTELLE, FILE, IMPOSTAZIONI, BARRE STRUMENTI,
PROFILO

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ dell’utente che vuole capire dove
Thunderbird installi le sue cartelle, cosa contengono tali cartelle, a cosa servono i file
contenuti in tali cartelle, come gestire il profilo.

Non sono delle FAQ strettamente tecniche, ma approfondiscono questi aspetti del
programma in una maniera piu incisiva.

Magagiori approfondimenti, ovviamente, si trovano anche sul Forum di Mozilla Italia, dove
vengono trattati gli aspetti piu approfonditi di altri sistemi operativi che non siano il solo
Microsoft Windows.
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Cartelle e file di Thunderbird: dove sono?

Problema

Si vogliono conoscere meglio le cartelle ed i file di configurazione del programma.
Ad esempio: dove si trova la cartella del profilo?

Soluzione

La maggior parte dei consigli e dei trucchi menzionati in queste FAQ richiedono una
modifica manuale dei file di configurazione di Thunderbird.

Ci sono tre file di cui si dovrebbero conoscere le funzioni:
user.js - Usato per cambiare tutte le preferenze.
userChrome.css - Usato per cambiare 'aspetto del programma.
userContent.css - Usato per cambiare l'aspetto delle e-mail.

Tutti questi file sono di solo testo e sono contenuti in una cartella dei profili.

Ma che cos’é un profilo?

Ognuno dei prodotti Mozilla (la Suite Mozilla/Seamonkey, Firefox, Thunderbird e Sunbird)
conservano le informazioni personali di un utente - per esempio i segnalibri, le email, le
rubriche degli indirizzi, le estensioni e le preferenze utente - in un unico profilo.

La prima volta che viene lanciato uno di questi programmi, viene creato automaticamente
il profilo di default; ulteriori profili possono essere creati utilizzando il gestore profili.

Tutti i settaggi che formano un profilo sono scritti in file che si trovano all'interno di una
speciale cartella nel computer: questa e la cartella del profilo.

Nella cartella del profilo, oltre ai file user.js, userChrome.css e userContent.css, ci sono
altri file (leggi qui).

| file user.js, userChrome.css e userContent.css, possono essere modificati utilizzando un
normale editor di testi; come Notepad o Texturizer in Windows e gedit o kate in Linux.

Prima di presentare i file di configurazione, si dovrebbe imparare come fare a trovare la
"cartella profile”, come € comunemente chiamata. La cartella profile e il posto in cui
Thunderbird salva tutte le tue impostazioni e si trova dentro il disco fisso.

Accedere SEMPRE al proprio profilo con Thunderbird chiuso!

Sistema Percorso della cartella Profilo
operativo
Windows 9x/Me C:\Windows\Application Data\Thunderbird\Profiles\<Profile name>\
Windows 9x/Me C:\Windows\Profiles\<Windows login/user name>\Application
(alternativa) Data\Thunderbird\Profiles\<Profile name>\

Windows NT 4.x C:\Winnt\Profiles\<sWindows login/user name>\Application
Data\Thunderbird\Profiles\<Profile name>\

Windows 2000/XP | C:\Documents and Settings\<Windows login/user name>\Dati
Applicazioni\Thunderbird\Profiles\<Profile name>\

Windows 2000/XP | Probabilmente, con Windows 2000 e XP non riuscite a trovare la
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(nota) cartella "Dati Applicazioni": infatti, essa € una cartella nascosta.

In Esplora Risorse (oppure con un doppio clic su “Risorse del
Computer”) fare clic su: Strumenti - Opzioni cartella - Visualizza >
Mostra cartelle e file nascosti.

Dal menu Start > Esegui...e possibile digitare direttamente
"%APPDATA%" (senza le virgolette) e dare I'lnvio per trovarsi subito
in una directory simile a questa:
%APPDATA%\Mozilla\Profiles\<Profile name>\*******x g]t\

(Per i curiosi: la stringa "%APPDATA%" per Windows 2000/XP & una
variabile locale che si aggiorna automaticamente al modificarsi del
nome utente che effettua il login e permettera di trovare
velocemente la cartella Application Data).

Unix ~/.thunderbird/<Profile name>/

Mac OS X ~/Library/Thunderbird/Profiles/<Profile name>/

~/Library/Application Support/Thunderbird/Profiles/<Profile name>/

Nota: Thunderbird € capace di gestire piu di un utente e, di conseguenza, piu di un profilo.
Gli esempi di percorso sopra menzionati si riferiscono al profilo di default che viene creato
automaticamente quando si avvia Thunderbird per la prima volta. E' possibile gestire un
gualsiasi numero di profili usando la Gestione profili.

user.js

Questo € un file delle preferenze dell'utente di Thunderbird e si trova nella cartella profile.
Il file non esiste di default, percido dovra essere creato prima di iniziare ad aggiungere le
proprie preferenze.

Utenti Windows: se si sa come creare un file, si puo saltare questa sezione. Prima di
poter creare il file, bisogna assicurarsi di poter vedere le estensioni dei file in Windows.
Aprire una cartella ed andare su “Strumenti - Opzioni cartella.... “ Fare clic sulla scheda
“Visualizzazione e togliere il segno di spunta alla voce “Nascondi le estensioni dei file per
i tipi di file conosciuti“. Successivamente aprire la cartella profile ed andare su “File 2>
Nuovo - Documento di testo“. Dovrebbe comparire il nome di default “Nuovo Documento
di testo.txt. “ Cambiare il nome in user.js (fare clic su “Si* quando appare il messaggio di
avvertimento).

Utenti Linux: diamo per scontato che se utilizzate Linux sapete anche come creare un
file. Create il file user.js nella cartella profile.

userChrome.css

Questo file imposta le regole di visualizzazione per svariati elementi dell'interfaccia utente
di Thunderbird e si trova nel percorso profile > chrome - userChrome.css.

Come per user.js, questo file non esiste di default, percio dovra essere creato prima di
iniziare ad aggiungere le proprie preferenze.

userContent.css

Questo file imposta le regole di visualizzazione per il contenuto delle e-mail (stili utente) e
si trova nel percorso profile - chrome - userContent.css.

Quindi, qualsiasi cosa sia inserita qui (in CSS) sara applicata alle pagine web visitate con
il programma, secondo quanto stabilito dalle regole di precedenza
(http://www.w3.0rg/TR/IREC-CSS2/cascade.html#cascade ) in CSS.
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Per assicurarsi che le proprie regole s'impongano sopra le regole specificate dalle pagine
web, utilizzare la regola limportant (http://www.w3.0rg/TR/CSS21/cascade.html#important-
rules ).

Come per user.js, questo file non esiste di default, percido dovra essere creato prima di
iniziare ad aggiungere le proprie preferenze.

Commento

Grazie a klades, a Leonardo Musumeci , a Lisman ed a David Tenser questa FAQ.
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prefs.ijs: che cosa sono?

Problema

Che cos’e il file user.js?

Soluzione

CHE COS'E:

- Il file user.js serve a creare delle personalizzazioni senza modificare direttamente quelle
di Thunderbird.

- Il file user.js, di norma, NON ESISTE, motivo per cui lo si deve creare manualmente
prima di iniziare l'inserimento delle proprie preferenze.

- Naturalmente, poiché questo e il file delle preferenze principali di Mozilla Thunderbird, si
trova nella cartella del profilo di default.

- Il vantaggio, ad esempio, e che copiando il file in un altro profilo, potete copiare tutte le
vostre personalizzazioni, senza dover modificare nient'altro - manualmente - all'interno del
programma.

E importante memorizzare questo: I' user.js influenza i settaggi di Thunderbird solamente
nel profilo dove viene messo!

In poche parole, per ogni profilo occorre creare un user.js, e il profilo senza questo file
rimane con i settaggi predefiniti!

COME SI AVWVIA:

Una volta che avete inserito le vostre preferenze nel file user.js del profilo scelto,
Thunderbird all'avvio lo carica automaticamente, per cui non c'é bisogno di fare chissa
cosa per farlo funzionare.

DOVE SI TROVA:

- In Windows:

La cartella del profilo contiene tutte le impostazioni salvate da Mozilla Thunderbird ed e
sempre presente nel proprio disco fisso.

Mentre, come detto, Il file user.js, di norma, non dovrebbe essere presente.

- In Windows XP/2000, il percorso del profilo & solitamente:
%AppData%\Mozilla\Thunderbird\Profiles\default.xxx\, dove xxx € una stringa casuale
di 3 caratteri.

Si apra la cartella C:\Documents and Settings\[User Name]\Dati
Applicazioni\Mozilla\Thunderbird\Profiles\

Il resto dovrebbe essere owvio.

- In Windows 95/98/Me, il percorso e solitamente:
C:\WINDOWS\Application Data\Mozilla\Thunderbird\Profiles\default.xxx\.

- Su Linux:
La cartella del profilo & in $SHOME/.mozilla/Thunderbird/xxxxxxx.nomeprofilo.

COME SI CREA:
- Il file user.js si crea manualmente, all'interno di un profilo.
Ricordate: il file user.js non € mai creato automaticamente!
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Prima di creare il file user.js, si deve essere certi di poter visualizzare le estensioni dei file
in Windows.

Si apra Explorer (basta fare clic sull'icona Risorse del Computer) e si selezioni il menu
“Strumenti = Opzioni cartella.... *

Nella scheda “Visualizzazione” si tolga la spunta a "Nascondi le estensioni per i tipi di file
conosciuti”.

Si raggiunga la cartella del profilo e si selezioni il menu “File - Nuovo - Documento di
testo®.

Verra creato un file “Nuovo Documento di testo.txt".

Si cambi il nome del file in "user.js" (apparira un messaggio di avviso in cui si deve fare

N

clic su “Si").

COME S| MODIFICA:

- Il file user.js € modificabile direttamente, tramite il Notepad di Windows.

Infatti, va bene anche il Blocco Note, ma occorre prestare attenzione alle estensioni del file
(magari si vede user.js ma in realta & user.js.txt).

Conviene disattivare I'opzione per nascondere le estensioni dei file conosciuti, come
spiegato prima.

Le modifiche che vengono fatte, tramite Thunderbird, dall'indirizzo fittizio "about:config”
oppure da “Strumenti - Opzioni” non toccano il file user.js, ma sono automaticamente
salvate nel file prefs.js generato automaticamente da Mozilla Thunderbird ed hanno
immediata applicazione.

Le modifiche effettuate a mano nel file user.js hanno invece applicazione solo dal
successivo riavvio di Mozilla Thunderbird.

Ricordiamo che in "about:config" verra mostrata una lista di tutte le preferenze disponibili
in Mozilla Thunderbird (molte delle quali sono derivate da Mozilla, ma non utilizzate da
Thunderbird né ancora rimosse).

Si faccia doppio clic su una preferenza per modificarne il valore.

E' importante tenere presente che se si modifica da "about:config" o dalle Opzioni una
preferenza che e stata definita anche nel file user.js, la modifica avra effetto solo per la
sessione corrente.

Infatti se mettete una preferenza in user.js, la maodificate da about:config, e poi riavviate
Thunderbird, la ritroverete com'era prima della modifica.

Quindi la regola e:

- i settaggi in user.js vanno modificati a mano con l'editor di testo;

- i settaggi che invece non sono contenuti in user.js possono essere modificati da
about:config oppure inserendo a mano il valore in user.js;

In altre parole il meccanismo € questo:

- in avvio Thunderbird "scrive" nel file prefs.js le preferenze contenute in user.js,
sovrascrivendo i valori impostati, quindi se non si cambia il contenuto di user.js (cosa che
si puo fare solo a mano), ad ogni avvio i suoi valori vengono applicati.

CHE COS'E PREFS.JS:

Ricordiamo che la differenza tra user.js e pref.js € questa:

- user.js viene creato e scritto dall'utente e di solito ci si mettono quelle impostazioni per le
guali non esiste una via di accesso dall'interfaccia grafica;

- prefs.js viene scritto dall'utente e creato da Thunderbird ogni volta che si chiude la
sessione, quindi ci vanno dentro tutte le impostazioni personalizzate che si immettono
dall'interfaccia grafica.

Anche il file prefs.js si puo aprire con il Blocco Note, se volete conoscere la sintassi dei
comandi.
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Attenzione: le impostazioni che si mettono in user.js vengono copiate da Thunderbird in
prefs.js.

Quindi, se mettete una preferenza in user.js e poi la volete cancellare, dovete farlo sia in
user.js che in prefs.js, a Thunderbird chiuso.

Se invece la dovete solo modificare, basta cambiare user.js.

QUALI PARAMETRI MODIFICARE:

Quale ¢ la via per inserire le proprie personalizzazioni in un profilo?

Per le versioni di Thunderbird fino alla 1.0.x, era possibile installare I'estensione
about:config.

Dalla versione 1.5, e possibile fare questo andando in “Strumenti - Opzioni > Avanzate
-> Editor di configurazione”.

Commento

Per maggiori notizie, provate a leggere questo: http://www.mozillaitalia.org/firefox/edit.html
(ma qui vi e solo un accenno al file user.js, il presente scritto € senz'altro piu completo).
Grazie a klades per questa FAQ.
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Barra strumenti: non memorizza le personalizzazioni?

Problema

Talvolta si ha un problema con la personalizzazione della barra degli strumenti di
Thunderbird. Praticamente non viene salvata la modifica e si & costretti ad effettuarla ogni
volta che si riavvia il programma.

Soluzione

1. Chiudere Thunderbird.

2. Trovare il file "localstore.rdf* dentro la cartella del profilo.

3 Cancellarlo (tanto verra ricreato automaticamente).

4. Riaprire Thunderbird e personalizzare la barra degli strumenti.

5. Chiudere Thunderbird.

6. Riaprire Thunderbird: la barra degli strumenti sara la stessa salvata in precedenza.

Commento

Prima di procedere, fare sempre una copia di backup del Profilo.
Nel file "localstore.rdf" ci sono le impostazioni salvate relative alla barra degli strumenti.
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Profilo; come crearne uno nuovo?

Problema

Nella maggior parte dei casi, la creazione di un nuovo profilo & la soluzione di tutti i
problemi, sia per Thunderbird che per Firefox.
Ma come si crea un nuovo profilo?

Soluzione

Bisogna avviare il programma con l'opzione —p .

Con Thunderbird e piu facile che con Firefox.

Infatti, quando si installa Thunderbird (con l'installer), tra i vari collegamenti nel menu
"Start - Mozilla Thunderbird”, c’é il "Profile Manager", dal quale é possibile creare il
profilo.

Ecco altri metodi per creare un nuovo profilo.
| modi per procedere sono diversi, a seconda del sistema operativo.

Ambiente Windows (primo metodo)

1. Chiudere Thunderbird (dal menu, selezionare File = Esci).

2. Selezionare Start > Eseqgui...

3. Nel campo “Apri”, digitare, tra virgolette, la posizione dell’eseguibile del
programma del quale si vuole creare un nuovo profilo, seguito da uno spazio e da —
p.

4. Le posizioni standard sono:
C:\Programmi\Mozilla Thunderbird\thunderbird.exe
pertanto, se si vuole creare un profilo di Thunderbird, la stringa completa sara:
“C:\Programmi\Mozilla Thunderbird\thunderbird.exe” —p

5. Se non si conosce la posizione dell’eseguibile (.exe), allora occorre utilizzare |l
pulsante “Sfoglia...” e navigare nelle proprie cartelle fino a trovare il percorso giusto
(se non lo si rintraccia, allora bisogna ricorrere alla funzione di Windows “Trova -
File o cartelle...” e, nel campo nome, inserire thunderbird.exe.

6. Fare clic su OK, poi si arrivera alla finestra della creazione del profilo.

7. Fare clic su “Crea Profilo” e, seguendo le istruzioni, potrete creare un nuovo profilo.

Ambiente Windows (secondo metodo)
1. Chiudere Thunderbird (dal menu, selezionare File > Esci).
2. Creare un nuovo profilo utilizzando l'icona del collegamento al programma.
3. Fare clic con il tasto destro sull'icona che utilizzate, e selezionando “Proprieta”,
potete modificare la riga usata per lanciare il programma come indicato in
precedenza.

Ambiente Linux
1. Chiudere Thunderbird.
2. Aprire una finestra della shell.
3. Posizionarsi nella cartella in cui € installato Thunderbird e digitare

Codice:
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Jthunderbird -P
oppure

Codice:
J thunderbird —Profile

Ambiente Mac Os X
Supponendo che Thunderbird sia stata posizionato all'interno della cartella Applicazioni si

deve:
1.
2.
3.

4.

Chiudere Thunderbird.

Aprire un terminale (si trova in Applicazioni - Utility).

Digitare:

cd /Applications

Digitare |s per ottenere I'elenco delle applicazioni; si dovrebbe trovare una cartella
Thunderbird.app.

Entrare nella cartella Thunderbird.app: € sufficiente digitare cd seguito dal nome
della cartella. Ricordate che e possibile far completare in automatico i nomi delle
cartelle premendo il tasto TAB come in Linux o Windows Xp.

Entrare nella Contents/MacOS (in pratica ci si trova in /Applications/
Thunderbird.app/Content/MacOS )

per avviare il gestore profili digitare

Codice:
Jthunderbird -P

oppure

Codice:
Jthunderbird —Profile

Una volta avviato il gestore profili, sara possibile eliminare o rinominare i profili.

Commento

Si tenga conto che il gestore profili potrebbe essere rimosso nelle prossime versioni del
programma.
Grazie a flod per questa FAQ.
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Profilo; come trasferirlo?

Problema

Si vuole trasferire un profilo.

Ma una volta che si va a sostituire il profilo, Thunderbird non si avvia lanciando il
messaggio di errore: "Thunderbird non puo avviare il profilo di default perché in uso".
Dopo un controllo di Windows, nei processi non c'e Thunderbird.exe avviato cosi come
nelle applicazioni.

Se, invece, si prova a creare un nuovo profilo con le caratteristiche del vecchio che si e
salvato, Thunderbird si avvia vuoto, senza menu e senza le mail salvate.

Soluzione

1. Chiudere Thunderbird.

2. Andare nella cartella del Profilo.

3. Verificare di avere i permessi di scrittura sulla cartella del profilo e che tale cartella non
sia in sola lettura.

4. Poi verificare anche se esiste un file lock o parent.lock e metterlo nel Cestino.

Se Thunderbird ancora non funziona (oppure non esiste il file lock o parent.lock, oppure la
cartella non € in sola lettura), seguire quest'altro procedimento:

1.Creare un profilo nuovo, preferibilmente disabilitando la "Global Inbox".

2. Creare gli stessi account che si avevano nel vecchio profilo.

3. A gquesto punto, dovete importare le mail dal vecchio profilo, ci sono due strade:

- 0 copiate i file senza estensione (Inbox, Sent, eccetera) dalle sottocartelle della cartella
"Mail" del vecchio profilo alle corrispondenti sottocartelle del nuovo profilo, sovrascrivendo
guelli dello stesso nome (fate questa procedura a Thunderbird chiuso, al riavvio dovreste
vedere le mail);

- oppure installare I'estensione mboximport e importare con questa i file delle mail e poi te
spostarle dove meglio piace con il drag&drop.

4. Per importare la rubrica dal vecchio profilo al nuovo, basta mettere il file abook.mab del
vecchio nel nuovo.

5. Per importare i filtri occorre copiare alcuni file, cercare sul Forum di Thunderbird per
trovare i nomi.

Commento

Prima di procedere, fare sempre una copia di backup del Profilo e soprattutto del file
Inbox.

Non cercare di importare mai le cartelle "chrome" ed "extensions" dal proprio profilo, per
evitare proprio che Thunderbird si avvii vuoto, senza menu e senza le mail salvate.

L'avvio in "Safe mode" di Thunderbird lo fa funzionare, solo che disattiva solo le estensioni
"moderne", quelle di vecchio tipo no (le vecchie estensioni prevedevano la possibilita di
installarsi globalmente).
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Profilo; come tenere due profili aperti contemporaneamente?

Problema

Si vogliono tenere, su Windows, due profili aperti contemporaneamente.

Soluzione

1. Aprire una shell del DOS.

2. Dare questo comando:
set MOZ_NO_REMOTE=1

3. A questo punto, ipotizzando che avete gia aperto Thunderbird con il profilo A, dalla
stessa shell lanciate thunderbird.exe -P profilo B e dovreste avere aperti i due
profili insieme!

4. Attenzione: se date solo thunderbird.exe -P vi si aprira il Profile Manager.

Commento

Lo stesso metodo vale anche per Firefox.

Un'alternativa comoda € creare un file batch cosi fatto (ovviamente il percorso
dell'eseguibile va adattato, se serve)

Codice:

@echo off
set MOZ_NO_REMOTE=1
"c:\Programmi\Mozilla Thunderbird\thunderbird.exe" -Profilemanager

e poi mettere un collegamento a questo batch nel menu Start, specificando da "Proprieta
", "Esequi ridotto a icona" (in modo da non avere la finestra nera aperta in primo piano).
Cosi facendo si avra un profile manager sempre disponibile, anche con un'istanza di
Thunderbird aperta.

Il discorso € perfettamente identico per Firefox.
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Safe mode: come avviare Thunderbird con questa modalita?

Problema

Come si fa ad avviare Thunderbird in safe-mode, cioé senza che siano attivi i temi e le
estensioni?

Soluzione

1. Chiudere Thunderbird.

2. Aprire la modalita Safe mode dal menu d'avvio di Windows: “Start - Programmi -
Mozilla Thunderbird - Mozilla Thunderbird (safe-mode) “,

3. oppure da “Start > Esegui...”, copiare ed incollare il seguente codice,

4. Codice:
"C:\Programmi\Mozilla Thunderbird\thunderbird.exe" -safe-mode

Commento

Lo stesso metodo vale anche per Firefox.
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« BACKUP

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ sul salvataggio delle e-mail, delle
impostazioni degli account (password, filtri, impostazioni personali, etc.).
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Backup manuale di account e messagqi nel profilo: come si

Problema

Si vuole fare un backup della posta, della rubrica, dei filtri e delle altre impostazioni di
Thunderbird: quali file occorre salvare?

Soluzione

| file e le cartelle da salvare si trovano tutti nella cartella del profilo, e sono:

o la cartella mail: contiene i messaggi di posta.
Ognuno dei propri account di posta/gruppi di discussione avra la propria
sottocartella all'interno della cartella Mail, ImapMail o News nella cartella del profilo,
ed i dati personali saranno memorizzati in questa sottocartella a meno di
configurazioni differenti (in Thunderbird e Mozilla Suite recenti & possibile utilizzare
la funzionalita Global Inbox per avere tutta la posta memorizzata solo in Cartelle
locali). Si noti che i file .msf sono file indice e non contengono alcun messaggio. Ad
esempio, se sono visibili "Inbox" e "Inbox.msf", il file contenente i messaggi e
"Inbox".
Una descrizione piu dettagliata di come salvare i messaggi di posta € gui.

o il file 12345678.s (il nome 12345678 € un esempio): questo file, il cui nome € un
numero di otto cifre, contiene le password degli account;

o ifile abook.mab e history.mab: Contengono la rubrica.
Per quanto riguarda la rubrica, bisogna copiare tutti i file *.mab.
Infatti, abook.mab € il file della rubrica "Rubrica personale".
invece, history.mab ¢ il file della rubrica "Indirizzi collezionati": se si crea una nuova
rubrica (apri la Rubrica e da menu “File” selezionare “Nuovo” e “Rubrica”)
Thunderbird crea istantaneamente un nuovo file (non é possibile stabilirne il nome a
priori) sempre con estensione *.mab.
| contatti nella rubrica sono salvati nei file con estensione *.mab, come scritto nelle
FAQ.
Le informazioni sull'esistenza di rubriche personali diverse da quelle di default
("Rubrica personale" e "Indirizzi collezionati"), sono salvate sul file "prefs.js" e sono
tutte le stringhe che iniziano con:
Codice:
user_pref("ldap_2.servers.

Ad esempio, se si crea una rubrica che si chiama "tittoproject”, per fare il backup
occorre salvare il file "imab-3.mab" e le stringhe:
Codice:
user_pref("ldap_2.servers.tittoproject.description”, "tittoproject™);
user_pref("ldap_2.servers.tittoproject.dirType", 2);
user_pref("ldap_2.servers.tittoproject.filename", "impab-3.mab");
user_pref("ldap_2.servers.tittoproject.isOffline", false);
user_pref("ldap_2.servers.tittoproject.protocolVersion”, "2");
user_pref("ldap_2.servers.tittoproject.replication.lastChangeNumber", 0);
o il file key3.db: contiene le password degli account;
o il file msgFilterRules.dat:contiene le definizioni dei filtri dei messaggi per un unico
account di posta.
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Ogni account avra il proprio file msgFilterRules.dat, insieme ai file di posta per tale
account, nella sottocartella account dentro la cartella Mail o ImapMail nella cartella
del profilo (come impostazione predefinita);
Attenzione: una volta riaperto Thunderbird, occorre provare ad eseguire i filtri, &
facile che siano disabilitati: dal menu “Strumenti - Filtri” si possono riabilitare.

o il file prefs.js: Contiene le impostazioni personali del programma, degli account
configurati e delle eventuali estensioni installate.
Se si sposta la cartella del profilo in un’altra posizione, puo essere necessario
modificare alcune impostazioni che fanno riferimento al percorso precedente. Per
farlo basta modificare questo file con un editor di testo. Si consiglia vivamente di
fare una copia di backup di questo file prima di procedere ad eventuali esperimenti.

o il file training.dat: Contiene le impostazioni per la posta indesiderata. Puo essere
letto con questo tool: http://bayesjunktool.mozdev.org/
il file user.js: Contiene le preferenze dell'utente di Thunderbird e si trova nella
cartella profilo. Il file non esiste di default, percio dovra essere creato prima di
iniziare ad aggiungere le proprie preferenze.
Se e necessario aggiungere manualmente elementi a pref.js, modificare questo file.
Le preferenze in esso saranno caricate al prossimo avvio, e poi salvate in prefs.js.
Eliminare elementi da questo file non cancellera gli elementi in prefs.js.
Per ulteriori informazioni, vedere qui.

Commento

Un discorso a parte meritano questi file, che non sono da salvare ma che si trovano
all'interno del programma:

o il file parent.lock (o lock, o .parentlock):
questo file segnala a Thunderbird che il profilo & utilizzato in quel momento, affinché
I'applicazione non provi ad utilizzarlo una seconda volta. Se si € certi che i processi
dell'applicazione sono stati terminati e che il proprio profilo non & ancora utilizzabile,
verificare se questo file & presente nella propria cartella del profilo. Se lo e,
eliminarlo. Se c'é, significa che I'applicazione ha dimenticato di cancellarlo dopo la
sua chiusura, e la sua esistenza impedisce l'accesso al profilo. Eliminandolo, il
problema si risolve;

o il file popstate.dat:
per tutti gli account di posta POP3, questo file tiene traccia di quali messaggi sono
stati scaricati dal server. Ogni account POP3 avra il proprio file popstate.dat,
insieme con i file di posta per tale account, nella sottocartella account dentro la
cartella Mail nella cartella del profilo (come impostazione predefinita). Poiché e il file
che memorizza le e-malil gia scaricate, se si prova a cancellarlo poi fa scaricare
nuovamente tutti i file presenti sul server di posta;

a il file profiles.ini (o registry.dat):
e memorizzato nella directory %appdata%\Thunderbird. Questo file tiene traccia di
dove sono tenuti i profili affinché Thunderbird possa trovarli all'avvio;

o il file xul.mfl (su Linux si chiama mflxul.mfasl):
questo e un file cache per i file utilizzati dall'interfaccia utente (XUL/JavaScript ed
altri). Viene utilizzato per memorizzare la rappresentazione interna dei dati per
evitare di analizzarli ad ogni avvio. Talvolta, il file pud danneggiarsi, ed in tali
situazioni, € sempre possibile cancellarlo, perché e una cache e sara ricreata al
prossimo awvio (anche se tale avvio potrebbe essere un po' piu lungo).
Suggerimento: Se si presentano problemi nell'installazione di versioni piu recenti o

Pagina 42 di 112


http://bayesjunktool.mozdev.org/

piu datate di Thunderbird (ad esempio, non si avvia), provare ad eliminare questo
file.

Grazie a jooliaan ed a klades per questa FAQ.

Pagina 43 di 112


http://forum.mozillaitalia.org/profile.php?mode=viewprofile&u=82
http://forum.mozillaitalia.org/profile.php?mode=viewprofile&u=761

Backup dei messaqqi e ripristino; come si fa?

Problema

Come ripristinare le mail dopo la creazione di un nuovo profilo e come farne una copia di
backup in caso di necessita?

Soluzione

Ci sono vari metodi per salvare gli archivi della propria posta.
Prima di questi metodi, pero, &€ necessario:

o salvarsi tutte le estensioni che saranno citate, che possono essere scaricate in
italiano da www.extenzilla.org o nella lingua messa a disposizione dall'autore nel
proprio sito. Per il programma “Mozbackup”, invece, scaricate la traduzione italiana
dal sito dell'autore;

o fare una copia di sicurezza (magari semplicemente copiando la cartella in un'altra
posizione) del vecchio profilo da importare.

Attenzione: tutti i metodi sotto descritti valgono solo per account POP: negli account IMAP,
infatti, le mail restano sul server e non ci sono problemi di sorta.

La guida € incentrata su Thunderbird, ma quanto scritto vale anche per Mozilla Mail,
tranne i metodi che consigliano di utilizzare le estensioni, poiché tali estensioni non sono
compatibili col programma Mozilla Mail.

1. Fare una copia di backup degli archivi di posta

[l primo metodo di salvataggio degli archivi di posta, € manuale, ed € sicuramente il piu
semplice di tutti: basta infatti copiare l'intera cartella del profilo, che poi potra essere
ripristinata tutta o in parte.

Attenzione: se avete intenzione di ripristinarla tutta, sappiate che il percorso che
dovra avere al momento del ripristino deve essere identico a quello che aveva
durante il backup.

Se, per esempio, siete su un sistema Windows 2000/XP o Linux il nome dell'utente che
accede al computer deve essere lo stesso di quello al momento del backup, inoltre anche
il nome della cartella del profilo dovra essere identico.

Per tale motivo, il nostro consiglio (se volete ripristinare tutta la cartella) € quello di copiare
i file non a partire dalla cartella del profilo, ma a partire dalla cartella "Thunderbird" (puo
chiamarsi thunderbird-bin su Linux), quella che contiene il file profiles.ini, e di metterla al
proprio posto al momento del ripristino prima di procedere con l'installazione di
Thunderbird.

Il secondo metodo per ripristinare tutto € utilizzare due estensioni: Accountex (serve alle
impostazioni degli account) e Mboximport (serve ad importare i vecchi archivi di posta).

o Per prima cosa dovete ripristinare gli account con tutte le loro impostazioni
(ovviamente dovete essere in possesso di una copia di backup per poterla
ripristinare: leggere la parte successiva sul backup del profilo).

o Installate quindi I'estensione Accountex e poi I'estensione Mboximport in un profilo
pulito di Thunderbird.

o Poi andate su “Strumenti > Opzioni” con Accountex e seguite la procedura per
esportare le impostazioni, ripetendo I'operazione per tutti gli account.

o A questo punto si puo decidere di copiare la cartella mail del profilo, unirla ai
salvataggi delle impostazioni fatti con l'estensione e usare questi dati per il
ripristino.
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a

a

Oppure si puo fare una copia di backup dei messaggi con mboximport: fare clic col
tasto destro sul nome dell'account nella finestra principale di Thunderbird.

Poi fare clic su “Esporta”. Una volta scelto il percorso dove salvare i file,
I'estensione si occupera di copiare tutti i messaggi dell'account. Ripetere questo
processo per tutti gli account presenti.

Nota: con Mboximport € anche possibile fare dei salvataggi mirati di una singola cartella;
basta fare clic col tasto destro sulla cartella invece che in cima all'albero dell'account.

Il terzo metodo per ripristinare tutto e utilizzare il programma esterno Mozbackup.

a
a

a

a

a

Scaricato il programma e scegliete (se volete) la lingua italiana.

Aprite il programma e impostatelo nella modalita di “backup profilo”, selezionando
Thunderbird come programma.

Nella finestra successiva, scegliete il profilo di cui fare il backup e decidete se
proteggerlo con password o meno.

Nella finestra seguente, selezionare quali componenti del profilo salvare e
terminare l'operazione.

Il programma dara come risultato finale un file .pcv (che poi altro non € che uno .zip
“travestito” con un’estensione diversa) che conterra tutto o parte del profilo.

Attenzione: vista la scarsa affidabilita dimostrata in passato da questo programma,
e comungue consigliabile fare una copia manuale della cartella mail del profilo.

2. Ripristinare le mail in un nuovo profilo
Il primo metodo per ripristinare tutto e fare le cose a mano, percio intanto rintracciate la

vostra cartella del profilo dove dovrete poi copiare i file.

a

Prima di copiare i file, perd, dovrete ricreare gli account con tutte le impostazioni
necessarie, preoccupandovi di non far scaricare a Thunderbird le eventuali mail
presenti sul server alla fine del processo di creazione dell'account. (Per fare questo
bastera togliere la spunta alla casella relativa quando comparira nella finestra)

Una volta creati gli account, nella cartella mail contenuta nella cartella del profilo
troverete tante cartelle quanti sono gli account che avete impostato, piu quella delle
cartelle locali. Le cartelle hanno il nome dell'indirizzo del server pop dell'account,
(ad esempio pop.tiscali.it) e, se avete piu di un account con lo stesso server, verra
aggiunto al nome un numero progressivo per differenziare le cartelle (ad esempio
pop.tiscali-1.it sara il secondo account impostato con quel server).

Per reimportare correttamente i messaggi, € percido necessario ricordarsi in che
ordine si sono creati gli account o, se il vecchio profilo € ancora raggiungibile, aprire
Thunderbird e andare su “Strumenti (0 “Modifica”, secondo il sistema operativo) >
Impostazioni account - Impostazioni server dell'account” e, nell'ultima riga in fondo
alla finestra, controllare il percorso della cartella.

Attenzione: tutte le operazioni di cancellazione e spostamento file che
seguono vanno fatte con Thunderbird chiuso!

Una volta individuato a quale cartella si riferisce ogni account, bastera andare nella
cartella del profilo nuovo, aprire la cartella mail e - in ogni sotto-cartella che si
riferisce agli account - cancellare tutti i file presenti (che, se non avete scaricato
mail, dovrebbero essere vuoti) e rimpiazzarli con quelli vecchi, che contengono tutti
| vostri messaggi.

Una volta copiati i vecchi archivi di posta, cancellate tutti i file con estensione .msf,
che saranno ricreati al riavvio successivo di Thunderbird.

A questo punto potete riavviare Thunderbird e dovreste trovare tutti i vostri
messaggi in ordine.
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Il secondo metodo per ripristinare tutto e fare le ancora una volta le cose a mano, pero

senza fare spostamenti di cartelle o cancellare file (infatti, e piu facile del primo).

a
a

O

Aprire Thunderbird e creare tutti gli account.

sempre con Thunderbird aperto, una volta creati tutti gli account, si deve creare
(per comodita) una nuova cartella dentro “Cartelle locali”, che potremmo chiamare
"Import".

Una volta creata la cartella, chiudete il programma di posta.

Andate dentro la cartella “Local folders” nel nuovo profilo, vi accorgerete che é stata
creata una cartella di nome Import.shd.

In questa cartella dovrete copiare i file senza estensione (sono quelli gli archivi della
posta) stando attenti, se avete piu account, a rinominare i file di nome uguale
oppure ad importare un singolo account alla volta.

Una volta copiati i file all'interno, aprite Thunderbird e noterete che all'interno nella
cartella “Import” che avete creato saranno presenti tutti i vostri archivi di posta, e
potrete spostare le mail all'interno del programma a vostro piacimento.

Questo metodo € piu lungo a dirsi che a farsi, e se lo provate una volta noterete che non e
poi cosi difficile.

Il terzo metodo per ripristinare tutto € utilizzare due estensioni: Accountex (serve alle

impostazioni degli account) e Mboximport (serve ad importare i vecchi archivi di posta).

a

Per prima cosa dovete ripristinare gli account con tutte le loro impostazioni
(ovviamente dovete essere in possesso di una copia di backup per poterla
ripristinare: leggere la parte precedente sul backup del profilo).

Installate quindi I'estensione Accountex in un profilo pulito di Thunderbird.

Poi andate su “Strumenti - Importa\esporta” con Accountex e seguite la procedura
di importazione per ogni account.

Una volta fatto questo, potete operare in due modi: andare nella cartella del profilo,
cancellare tutto il contenuto della cartella mail e sostituirlo col contenuto della
vecchia cartella e poi cancellare tutti i file .msf oppure utilizzare I'estensione
Mboximport per importare tutto. Vediamo come.

Installate I'estensione Mboximport.

Poi andate su “Strumenti - Importa Mbox” e, nella finestra che si apre, fare clic su
“Importa” e selezionare il file da importare (ricordo che i file degli archivi sono i file
senza estensione).

Dopo aver fatto tutto, come del resto avvertira I'estensione, vi ritroverete i vostri
messaggi in una sotto-cartella di “Cartelle locali” e potrete spostarli a vostro
piacimento dove vi servono.

[l quarto metodo per ripristinare tutto € utilizzare il programma esterno Mozbackup, e

verra spiegato come ripristinare una copia di backup gia esistente.

a

a

Una volta messa la lingua italiana (se volete) sovrascrivendo il file in inglese,
avviate il programma.

Impostate Mozbackup su “Ripristina profilo”, scegliendo Thunderbird come
programma.

Nella finestra successiva, scegliete il nuovo profilo creato come destinazione.
Nella finestra seguente, selezionate i componenti che volete importare. Se state
facendo un recupero di fortuna e avete fatto il backup utilizzando il vecchio profilo
corrotto, vi consigliamo di selezionare solamente le voci "Mail" e "Rubrica indirizzi",
altrimenti decidete voi.

Una volta terminato il programma, non dovrete fare altro che aprire Thunderbird e vi
troverete con i vostri messaggi in ordine dove devono essere.
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Attenzione: in passato (ve lo diciamo per esperienza) questo programma ha dato
non pochi grattacapi agli utenti, e si e rivelato tutt'altro che affidabile.

Vi consigliamo percio, se usate questo programma, di fare una copia di backup
manuale della cartella “mail” del profilo, cosi potrete sostituirla a quella che
ripristina il programma nel caso vi accorgiate che mancano dei messaggi, o nel
caso ci siano dei problemi col file di backup.

Commento

Grazie a iacchi per questa FAQ.
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« CONFIGURARE THUNDERBIRD CON ALTRI PROGRAMMI

Che cosatroverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ dell’'utente che vuole capire come
configurare Thunderbird con altri programmi.

Non sono delle FAQ che guidano alla configurazione di un firewall o di un antivirus
(questo, semmai, & qualcosa che dovrebbe offrire proprio il programma che si va a
configurare con Thunderbird), ma delle FAQ che risolvono una parte dei dubbi relativi al
“dialogo” tra Thunderbird ed un altro programma.
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Configurare FreePOPs: come?

Problema

Puo capitare di avere una casella di posta elettronica cui non é possibile accedere
direttamente utilizzando il programma di posta preferito (cioé Thunderbird) e di essere
costretti a consultarla solamente via web: il classico esempio e un account su Hotmail.

Il problema riguarda anche la consultazione di caselle di posta di un provider utilizzando la
connessione di un altro fornitore: ad esempio, non €& possibile consultare con il protocollo
POP3 la posta di Virgilio da una connessione Libero.

Esistono alcuni programmi in grado di aggirare il problema, consentendo di scaricare la
posta in arrivo direttamente con Thunderbird, uno di essi & FreePOPs.

Soluzione

La presente FAQ non vuole essere un manuale esaustivo sull'uso di FreePops.

Per le opzioni avanzate del programma e per la risoluzione di eventuali problemi, vi
invitiamo a leggere il manuale (http://www.freepops.org/it/doc.shtml) ed a consultare il
forum di supporto del prodotto (http://freepops.diludovico.it/index.php).

FreePOPs é un software multipiattaforma, cioe é disponibile per Windows, Unix, Linux e
Mac OS X. Lo si puo scaricare da http://www.freepops.org/it , sezione download.

Le seguenti spiegazioni sono riferite alla versione per Windows, ma possono essere
adattate anche ad altri sistemi operativi.

Una volta scaricato ed installato il programma, avviarlo da menu “Start > Programmi -
Freepops > Freepops*. E' possibile verificarne la presenza tra i programmi attivi,
attraverso un'icona nella system tray di Windows (normalmente in basso a destra, accanto
all'orologio).

L'esempio seguente riguarda la configurazione per una casella su Hotmail; per un elenco
completo di tutte le webmail gestibili con FreePops consultare la pagina
http://www.freepops.org/it/viewplugins.php .

Dopo aver creato, in Thunderbird, il nuovo account "Hotmail" secondo la procedura
standard di creazione di un nuovo account, configurarlo con le seguenti impostazioni:
“Strumenti = Impostazioni Account - (account appena creato su Hotmail).

Nella scheda “Impostazioni Server” vanno inseriti i seguenti parametri:
o Nome server: localhost (scritto proprio cosi);
o Porta: 2000;
o Nome utente: nomeutente@hotmail.com (infatti, Il nome utente deve essere uguale
all'indirizzo di posta elettronica su Hotmail).
A questo punto, se tutto é stato configurato correttamente, sara possibile ricevere la posta
attraverso la casella di Hotmail su Thunderbird.

Alcune considerazioni finali:
o puo essere comodo porre |'eseguibile di FreePops
(C:\Programmi\freepops\freepopsd.exe) in esecuzione automatica di Windows, per
evitare di lanciarlo manualmente;

Pagina 49 di 112


http://www.freepops.org/it/doc.shtml
http://freepops.diludovico.it/index.php
http://www.freepops.org/it
http://www.freepops.org/it/viewplugins.php
mailto:nomeutente@hotmail.com

o se si utilizza un personal firewall (come ZoneAlarm), bisognera consentire al
programma FreePops di attraversarlo, altrimenti, anche se I'account & configurato in
Thunderbird, non si potra ricevere la posta;

o FreePops serve per ricevere, non per inviare posta (lo puo fare, pero, un
programma simile Html2pop3). Come server SMTP per I'account appena
configurato si deve usare quello del proprio provider;

o tutte le altre mailbox che FreePops puo gestire (Libero, Supereva, etc.) si
configurano in maniera simile a quella di Hotmail. Per ulteriori informazioni
consultare la pagina http://www.freepops.org/it/viewplugins.php .

Commento

Periodicamente, i provider che ospitano le webmail aggiornano i loro siti, con il risultato
che FreePops, da un giorno all'altro, potrebbe non riuscire piu ad accedere alla casella di
posta e scaricare i messaggi in Thunderbird.

Quando cio accade, si consiglia in primo luogo di controllare sul sito del programma se
siano stati rilasciati aggiornamenti.

In caso contrario, 0 per sapere come installare tali aggiornamenti, vi invitiamo a consultare
il forum di FreePops.
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Configurare Gmail: come?

Problema

Gmail (la casella di posta elettronica di Google, attualmente di ben 2 GB), all'inizio, non
era facilmente configurabile con Thunderbird, poiché richiedeva la sola lettura tramite web
mail.

Attualmente la situazione e — fortunatamente — cambiata e Gmail fornisce i parametri di
connessione pubblicati in questa FAQ.

Anche se Gmail fornisce spiegazioni e screenshots in inglese, la configurazione e davvero
semplice!

Soluzione

1. Aprire Thunderbird, e selezionare “Impostazioni account...” dal menu “Strumenti”.

Fom =
Q Local Folders - Mozilla Thunderbird
File Edit Mew Go  Message | Tools  Help
<7 ~=1 fddress Book
V;%' - ,{E; 'n.._:J.'-lI" Extensions i
ek Mail Write  Address Book Themes |
Faolders Message Filkers, .. I
|
= E—J Local Folders
i Inbox Junk Mail Conkrals, .
_(fj Unsenk Messages
_,'j Drafts
=] Templates Import, ..
-_}_I Sent Javascript Console
1.2 Trash Account Setkings. ..
Opkions...
Advanced Featlires )
2. Premere il pulsante “Aggiungi S—
account” in basso a sinistra. Dal New Account Setup
menu che si apre in seguito,
SeleZionate “Account dl pOSta” e In order ko receive messages, you First need to set up a Mail or
. “ 39 Mewsgroup accounk.
fate Cl IC SU Avantl . This Wizard will collect the information necessary bo set up a Mail or

Mewsgraup account, IF you do not know the information requested,
please contack vour System Administrator or Internet Service
Provider.

Select the bype of account you would like ko set up:

©i !
() R55 News # Blogs

O MNewsgroup accaunkt

l Mexk = J ’ Cancel ]
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3. Inserite il vostro nome completo nel campo “Nome”. Poi inserite il vostro indirizzo
Gmail completo (username@gmail.com) nel campo “Indirizzo email”. Fate clic su
“Avanti”.

P )

Account Wizard

Identity

Each account has an identity, which is the information that identifies
wou bo others when they receive your messages,

Enter the name you would like to appear in the "From® field of wour
outgoing messages (For example, "John Smikh"),

Your Mame: Mathan Woodweard

Enter wour email address. This is the address others will use to send
email ko you (For example, "user@example.net™).

Email Address: nanowoodward@gmail,com

< Back ] I Mext = I [ Cancel

= b

Account Wizard

4. Selezionate il pallino “POP” nel | Server Information
tipo di server che utilizzerete.

Poi inserite (Senza le VirgOIGtte, Select the bype of incoming server you are using.
ovviamente) “pop.gmail.com” @ POP () AR

nel campo “Server in ingresso”.

Fate C“C su “Avanti”. Frztanil:et:aemn;;nistfugflour incoming server (for example,

Incorming Serwver: pop.gmail.con‘l

Uncheck this checkbosx to store mail For this account in ks own
directory. That will make this account appear as a top-level account,
Otherwise, it will be part of the Local Folders Global Inbox account,

IJse Global Inbos (store mail in Local Folders)

‘Your exisking outgoing server (SMTP), "smtp”, will be used, You can
modify outgoing server settings by choosing Mail 8 Mewsgroups
Account Settings Fram the Edit menu,

< Back l I Mext = ‘ [ Cancel l
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5. Inserite il nome del vostro account nel campo “Nome utente posta in entrata”.
Fate clic su “Avanti”.

»
Account Wizard

Account Name

Enter the name by which you would like to refer ta this account {for
example, "Work Account”, "Home Account” or "Mews Account™),

Account Mame: Gmail

< Back ] I et = I [ Cancel

6. Inserite il nome del vostro account nel campo “Nome account”. Fate clic su
“Avanti”.

= =)

Account Wizard

User Mames

Entet the incoming user name given ko yau by wour email provider
(For example, "jsmith"],

Incoming User Mame:  |nanowoodwardi@grnail.com

Enter the oukbgaing user name given ko wou by your email provider
(this is bvpically the same as your incoming user name).

Qubgoing User Mame: nannwnndward@gmail.curd

< Back ] I Mexk = I [ Cancel
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7. Verificare che le informazioni riassunte nel box successivo siano corrette e fare clic

su “Fine”.

»
Account Wizard

-,

Congratulations!

Account Marme:

Email Address:

Incoming User Mame:

Incoming Server Mame:
Incoming Server Type:
Qukbgaing User Mame:
OQutgoing Server Mame (SMTR):

Flease verify that the information below is correct,

Gmail
nanowoodward@gmail. com
nanowoodward@gmail. com
pop.gmail.com

POP3
nanowoodward@gmail. com
smtp

Click Finish to save these settings and exit the Account Wizard,

[ <« Back ] I Finish I [ Caniel

8. Selezionate “Impostazioni server

dal menu del vostro nuovo account.

9. Spuntate la casella “Usa connessione criptata (SSL)”, e assicuratevi che nel campo

“Porta” appaia “995".

=
Account Settings

-

Local Folders
= nanowoodward@gmail.com

Server Settings
Copies & Folders
Composition & Addressing
Disk. Space
Return Receipks
Securiby

Cubgoing Server (SMTR)

[ Add Account. .,

[ Rermowve Accounk

I

Server Settings

POP Mail Server

pop.amail.com

Server Type:

Server Mame: Port: 995 Default; 995

ser Mame: nanowoodward@agmail . c

Server Settings

[v]: Use secure connection (55L)

|:| IUse secure authentication

Check For new messages at skartup
Check For new messages every |10 rminutes
Automatically download new messages

[] Fetch headers only

[] Leave messages on server
[] Empty Trash on Exit

Local direckory:

Ci\Documents and Settingstgoogleadmintapplication Daka) Thu

I Ok l [ Cancel I [ Help ]

10. Selezionate “Server in uscita (SMTP)” dal menu del vostro nuovo account.
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11.Inserite, ovviamente senza virgolette, “smtp.gmail.com

nel campo “Nome server”

, € assicuratevi che nel campo “Porta” appaia “587".

= -1
Account Settings
el 4o Outgoing Server (SMTP) Settings ‘
= nanowoodward@gmail.com
S Sekti
er\fer S Only one oukgoing server (SMTF) needs to be specified, even if vou have
Capies & Faolders several mail accounts, Enter the name of the server For oubgoing
Campasition & Addressing MEssa0es,
Disk Space
Return Receipts Server Mame:  |smtp.gmail. comm Port: 557 Default: 25
Security IJse name and password
Outgoing Server (SMTP) User Mame: nanowoodward@amail.com
Use secure connection:
O Mo (O TS, Favalable  @&ITLS (O 55t
Add Account...
I a4 ] [ Cancel ] [ Help ]

12. Sotto, spuntate la casella “Utilizza nome utente e password”, poi inserire il nome
dell’'account completo (username@gmail.com, ovviamente senza virgolette) nel

campo “Nome utente”.

13. Nelle opzioni “Utilizza connessione sicura” spuntare “TLS” (attenzione: non

spuntare “TLS, se disponibile™). Fare clic su OK.

Commento

Avete fatto clic su “Save Changes” dopo avere abilitato il POP

in Gmail? Per essere sicuri

che Gmail possa comunicare con il programma di posta elettronica, assicurarsi di fare clic

su “Save Changes” nella pagina “Mail Settings” di Gmail.
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« ESTENSIONI

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ sulle estensioni di Thunderbird.
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Estensioni; cosa sono?

Problema

Cosa sono le estensioni?

Soluzione

Le estensioni sono delle piccole aggiunte nel codice del programma, che aumentano le
sue funzionalita.

Il sito italiano di riferimento delle estensioni & www.extenzilla.org .

Qui http://forum.mozillaitalia.org/viewtopic.php?t=7640 c’e una lista delle estensioni per
questo programma.

Commento

Grazie a restimaxgraph per questa FAQ.
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Estensioni; come si installano?

Problema

Cosa si installano le estensioni?

Soluzione

Premessa: in precedenza avrete gia salvato con il browser I'estensione (.xpi) per
Thunderbird in una cartella del disco fisso.

Gl Apri in nuova finestra
T Apri in nuova scheda
- Agagiungi link nei segnalibri. ..
Ty

 Invia link. ..

Salva destinazione come. ..

Copia indirizzo

Stampa...

—

0 Proprietd

Cominciamo: aprite Thunderbird.

1) Fate clic sulla voce "Strumenti": si apre un

"Estensioni".

menu a tendina e fate clic su

& Cartelle locali - Mozilla Thunderhbird

Elle Modifica Visualizza WVai  Messaggio | Strumenti 2
@j ﬁ .g Chrl+2
Cartell .
A M¢  Codifica caratteri r heali
EI=}cartelle locali Eiltri
2 Posta in arrivo (21} At .
\fq Posta in uscita N N 3
Zontrolli posta indesiderata, ..
3! Bozze =
) Posta inviata M
@ Cesting
Importa,.,.
E Console Javascript
Impostazioni account,.,
Opzioni...
Caratteristcne avanzate
P
Q Cerca ressaggi
L:J Gestione filtri ressaggl
2 Hon letti: 21 Totale: 34

2) A guesto punto s'e aperta la

"Gestione Estensioni", fate clic su "Installa”.
e LB

B podfcn ke Ve

%&- 2 W

Cartsle

i Lartelle locall
A Pestain arrivo (213

I I Encakisracione Rakaa 0.5
4 Tradaore Eabana & Thunderded

Momletti: 2L Totale: M
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3) Ora cercate la cartella dove avete salvato in precedenza I'estensione, una volta trovata
la selezionate e fate clic su "Apri".

# Cartelle locali - Mozilla Thunderbird

File Modifica Visualizza Yai  Messaggio  Strumenti 7
g Ll = Estensioni
Cartelle ) . ) E
- Selezionare un‘estensione da installare
=] Q Cartelle
; 4 Posta Cercain: | cartella egtenzioni
- Posta
: A Bozze 78
7] Posta
@ Cestin P s
Cfi_
Desktop
e
-,
=
Dacumenti
. Mome file; |estensi0ne.xpi Y| L Apri ,]
F"ﬂ'i?:iidjl Tipo file: |Estensioni [".%pi) v| [ Annulla J

4) Finalmente parte l'installazione vera e propria: si apre la finestra "Installazione
estensioni", se avete scaricato I'estensione da un sito fidato (leggasi www.extenzilla.org)
fate clic su "Installa adesso", il procedimento terminera in pochi secondi.

Installazione estensioni | X ‘

Un sito web chiede |'autarizzazione ad installare il seguente oggetta:

@ estensione Non firmata
Bl /1C:iDocume: 0 »205ettings{ andrealD)

Software contenente istruzioni sospette potrebbe danneggiare i dati
cantenuti in questa computer o wiolare la propria privacy.

Si dovrebbe installare solo materiale proveniente da siti

di cui ci si fida.
instalo aceseo

5) A questo punto...chiudete e riavviate Thunderbird!
Oppure c'é un secondo metodo, leggermente piu veloce:

Dopo avere aperto la "Gestione Estensioni” come al punto 1) trascinate, prendendola col
puntatore del mouse, I'estensione che volete installare direttamente in questa finestra.
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estensione. xpi Estensioni [
o

Netscape Theme or Exten
A

199 KB

I Localizzazione italiana 0.3
Traduzione italiana di Thunderbird

d k.xp
) Metscape Theme or Extension ...
- &99 KB

]

3y Installs | X Disinstala | 49 aggiorna | | 47 Opaioni | Scarica estensioni

|

Si aprira cosi "Installazione estensioni" come al punto 4) dopo di che ovviamente dovrete
fare clic su "Installa adesso".
Infine, come gia detto...chiudete e riavviate Thunderbird!

Commento

Grazie ad Andr3a per questa FAQ.

Pagina 60 di 112


http://www.extenzilla.it/forum/profile.php?mode=viewprofile&u=19

Inibire ad alcuni utenti il download di Estensioni e Temi: come?

Problema

Si vuole inibire a degli utenti di scaricarsi temi ed estensioni.

Soluzione

1. Se si & amministratore di rete nelle impostazioni del proxy/firewall/router della LAN
mettere in blacklist I'ip di: https://addons.mozilla.org/ www.extensionsmirror.nl
www.extenzilla.org , *.mozdev.org .

2. Una certa protezione puo essere questa:
mettere in user.js dei profili di ogni utente queste righe (servono a disabilitare
I'installazione di pacchetti xpi e ad annullare il link al sito dei temi)

user_pref("xpinstall.enabled", false);
user_pref("extensions.getMoreThemesURL", "");

Poi mettere queste altre nel file userChrome.css (servono a nascondere i bottoni
Strumenti - Estensioni e Strumenti = Temi)

#extensionsManager,
#themesManager {
display:none limportant;

}

Questo € abbastanza efficace, sempre che l'utente non sia abbastanza scaltro da
andare a modificare questi file (magari mettendoli di sola lettura - se si utilizza
Linux si potrebbero blindare con i permessi da root).

3. Ecco una variante un po' piu sadica della precedente.
Andare nella cartella di installazione del programma, nella directory defaults, poi
nella directory prefs.
Apri il file all-thunderbird.js, trovare questa riga:

pref("app.id", "{3550f703-e582-4d05-9a08-453d09bdfdc6}");

e cambiarla in

Il pref("app.id”, "{3550f703-e582-4d05-9a08-453d09bdfdc6}");

Aggiungere alla fine

pref("xpinstall.enabled”, false);

A questo punto nessun utente puo piu installare nulla, senza che tocchi i loro profili.
Ed e piu difficile da aggirare perché basta proteggere la cartella di installazione del

programma , oltre che piu complicato da capire.

ATTENZIONE: ogni volta che si aggiorna Thunderbird, occorre ripetere la modifica.
Inoltre alcune funzioni, tipo I'aggiornamento automatico, potrebbero non funzionare.

Per ripristinare la possibilita di installare estensioni e temi, basta annullare le
modifiche.

Pagina 61 di 112


http://www.extensionsmirror.nl/
http://www.extenzilla.org/

Inoltre, se si vuole che un certo profilo non abbia queste limitazioni, basta mettere in
user.js queste righe

user_pref("app.id", "{3550f703-e582-4d05-9a08-453d09bdfdc6}");
user_pref("xpinstall.enabled"”, true);

Commento

Non utilizzare questi suggerimenti se non si sa bene cosa si sta facendo.
Grazie a klades e jooliaan per questa FAQ.
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* FILTRI

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ sui filtri di Thunderbird.
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Filtro: bayesiano, cos’e?

Problema

Che cos’e il filtro di Bayes?

Soluzione

Sicuramente su Internet troverete una spiegazione migliore della nostra!

In parole povere, un filtro bayesano si occupa di riconoscere lo spam non solo in base al
mittente (filtro un po’ inutile, giacché lo stesso spammer potrebbe cambiare identita ad
ogni messaggio di spam) ma anche in base al suo contenuto.

Ad esempio, dopo un periodo di addestramento (consistente semplicemente nel fare clic
sul pulsante "Posta indesiderata”), Thunderbird riconosce delle parole chiave — che hanno
una certa relazione tra loro — come spam (ad esempio: viagra, sex, special sale, offer,
etc.).

Un trucco in voga tra gli spammer e quello di "inquinare” i filtri bayesiani infarcendo il
messaggio di parole rare (alger, est, euripides, seidel, elute, geriatric, etc.) o volutamente
storpiate (v!agra, s&x, spec!@| s@le, off&r, etc.), ma ben presto Thunderbird riconosce
anche queste parole!

Un altro trucco in voga tra gli spammer e quello dei messaggi costituiti esclusivamente da
immagini contenenti il testo della pubblicita, ma siccome Thunderbird non visualizza
automaticamente le immagini, il risultato € un messaggio vuoto.

Un altro trucco in voga tra gli spammer e quello dei messaggi “diluiti”; ma tali messaggi
sono talmente “diluiti” nel loro contenuto da essere praticamente inservibili: non possono
contenere nomi di prodotti o nessuna delle tipiche parole delle offerte d'acquisto, ed e
molto difficile cercare di vendere qualcosa quando non se ne puo parlare.

L’ultimo trucco — il piu recente — in voga tra gli spammer si basa su una e-mail che
presenta diversi contenuti in base alla visualizzazione HTML o solo testo; per il momento
Thunderbird fatica a contrastare tale trovata, pero € sufficiente impostarlo per la lettura dei
messaggi in solo testo e lo spam e sconfitto!

Ma, piu che lo spam eliminato, conta la percentuale di insuccesso del filtro, ossia di
messaggi che Thunderbird considera erroneamente spam quando non lo sono:
ovviamente dovrebbe essere (e lo é!) zero.

Molti utenti sono restii ad utilizzare i filtri bayesiani anti-spam perché temono che releghino
nello spam qualche messaggio legittimo (magari attinente al proprio lavoro) ma
difficilmente Thunderbird, dopo I'addestramento, sbaglia!

Niente male, per uno strumento cosi semplice da usare.

C'e anche un'altra tecnica, molto astuta, utilizzata da Thunderbird per discriminare fra
spam e messaggi legittimi: gli indirizzi ai quali si manda un messaggio vengono
automaticamente considerati legittimi, a prescindere dal contenuto delle e-mail che
mandano.

Questo significa che tutti i vostri amici, colleghi e conoscenti ai quali scrivete finiscono
automaticamente in una "lista bianca" di indirizzi che non verranno mai considerati
spammer.

Tutti gli altri sono considerati possibili rompiscatole fino a prova contraria. E' grazie a
guesta finezza che i vostri amici possono mandarvi persino un testo di uno spam senza
per questo finire cestinati dal filtro...
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Commento

Non utilizzate il filtro di Bayes come filtro per smistare la vostra posta: € un gravissimo
errore!

Inoltre, non usare I'anti-spam bayesiano nei confronti di e-mail indesiderate che hanno un
mittente fisso come (ad esempio) newsletter sgradite o le e-mail pubblicitarie del vostro
provider (che siete obbligati a accettare per contratto): nei confronti di questi messaggi €
bene usare, se lo desiderate, il filtro messaggi.

Il motivo e che il filtro bayesiano lavora per parole chiave, ad ogni parola & assegnato un
punteggio, quando nel messaggio una serie di parole fa superare una certa soglia di
punteggio, scatta la classificazione come spam.

Usare il filtro bayesiano nei confronti di e-mail si moleste ma con mittente fisso come le
newsletter del vostro provider puo far credere al filtro che alcune parole contenute in tali
messaggi siano indizio di un messaggio di spam, portandolo quindi a possibili futuri
errori.

Per prudenza, comunque, lo spam che ricevete non cestinatelo, ma trasferitelo
direttamente in un'apposita cartella, che poi sfoglierete periodicamente per verificare che
Thunderbird non abbia ecceduto nel proprio zelo.

Grazie a Paolo Attivissimo (www.attivissimo.net ) ed a Winzozz
(http://home.tiscalinet.ch/winzozz/sikurezza.htm ) per questa FAQ.
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* GLOBAL INBOX
Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ sulla “Global Inbox” (“Posta in
Arrivo globale”).

Le FAQ non sono numerose perché questa funzione € poco utilizzata.
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Global Inbox: come attivare / disattivare tale funzione?

Problema

Non si riesce a ricevere la posta.

Soluzione

La funzione Global Inbox, in italiano Posta in Arrivo globale, introdotta a partire da
Thunderbird 0.9, permette di utilizzare I'account Cartelle Locali per gestire le caselle di
posta senza replicare la medesima struttura di cartelle (posta in arrivo, cestino, ecc.) n-

volte per n account.

E' possibile attivare questa funzione a livello del singolo account: ad esempio, sara
possibile avere due account separati (senza la Global Inbox) e due account che utilizzano
direttamente le Cartelle Locali.

Per attivare/disattivare questa funzionalita , andare in Strumenti (modifica) = Impostazioni
account, selezionare I'account, entrare nel pannello Impostazioni Server, fare clic sul
pulsante Avanzate...

Nella finestra successiva, entrare nella sezione POP e selezionare I'impostazione
desiderata.

= mMpostaZioni avaniate per 'accoun O %

SMTF| POF

Quando scaricate la posta pop3 da questo server, potete memorizzare
nella cartella posta in arrive globale (posta in arrivo di Cartelle Locali), nella
cartella posta in arrivo per questo account, o nella cartella posta in arrivo di
un altro account pop3.

() Posta in arrivo globale (Cartelle Locali)

(® {'Posta in arrive’ per 'account di questo server

() Posta in arrive di un altro account.

Annulla Ok

Commento

Grazie a flod per questa FAQ.
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« MESSAGGI

Che cosatroverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ di come gestire i messaggi (“e-
mail”) di posta elettronica.

Ci sono molteplici aspetti della loro gestione che, dato il loro numero considerevole,
ovviamente non possono essere tutti trattati qui.

Il nostro consiglio, pertanto, € sempre lo stesso: collegatevi al Forum di Mozilla Italia e —
con la funzione di Cerca nel Forum - consultate i numerosi argomenti al riguardo.
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Messaggi: compattare le cartelle, perché e consigliabile?

Problema

Quando spostiamo o cancelliamo un messaggio da una cartelle, Thunderbird (cosi come
fanno altri programmi di posta) lo "nasconde" (etichettandolo come messaggio da
cancellare permanentemente), e questi messaggi hascosti rimangono nella cartella finché
essa non viene compattata.

Nemmeno uno svuotamento del cestino li cancella.

Se non si esegue periodicamente la procedura di compattazione, gli archivi di posta
possono crescere di dimensioni in maniera incontrollata e possono cominciare a
presentarsi stranezze ed anomalie nell'utilizzo di Thunderbird.

Esempi di problemi:

o il programma e lento ad avviarsi, infatti quando si lancia Thunderbird , puo
accadere che si rimanga in attesa diversi minuti, prima di veder comparire i
messaggi della Inbox (Posta in arrivo).

o anche se una cartella sembra vuota o quasi vuota, gli archivi di posta occupano
un’ingente quantita di spazio su disco fisso;

o nello scaricare i nuovi messaggi, occasionalmente compaiono copie di messaggi
gia ricevuti;

0 messaggi cancellati o spostati in altre cartelle possono stranamente riapparire in
cartelle dove non dovrebbero essere;

o il software antivirus potrebbe individuare messaggi infetti cancellati molto tempo
prima (anche se si e svuotato il Cestino di Thunderbird);

o siverificano problemi nella deframmentazione del disco fisso;

o il numero dei messaggi presenti indicato puo diventare enormemente maggiore del
reale numero di messaggi presenti

Come compattare, allora, le cartelle degli account?

Soluzione

Per compattare tutte le cartelle di un account (é sconsigliato lo scaricamento dei messaggi
durante questa procedura; € bene quindi eseguirla mentre si & scollegati dalla rete ,
oppure, se € installato il supporto per lavorare “Non in linea”, andare su “File = Non in

linea - Lavora scollegato”):

1. cancellare eventuali messaggi inutili presenti nelle varie cartelle (Posta
indesiderata, Cestino, Posta inviata eccetera) dell’account desiderato;

2. selezionare un account dall'elenco cartelle (quello a sinistra dell'interfaccia di
Thunderbird);

3. fare clic su “File > Compatta cartelle”. Quest'operazione puo richiedere pochi
secondi o pochi minuti, a seconda della quantita di posta e dal tempo intercorso
dalla precedente operazione di compattazione.

4. Se si verificano errori e il processo va in stallo, &€ possibile compattare le cartelle
una per volta (facendo clic col tasto destro su una cartella e scegliendo "Compatta
guesta cartella").

Se l'operazione non sembra essere efficace nemmeno per una singola cartella di
posta, € possibile che i file MSF (mail summary file, gli indici), siano corrotti.
Per risolvere questo problema:
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Chiudere Thunderbird.

Fare una copia di backup del proprio profilo.

Nel proprio profilo (e nelle sue sottocartelle), cancellare tutti i file con estensione
.msf. Questi sono degli indici che Thunderbird crea automaticamente al riavvio, in
realta non si cancella alcun messaggio (i messaggi "veri" sono quelli senza
estensione).

4. Tentare nuovamente la compattazione e controllare se funziona.

5. Si puo tranquillamente, poi, fare ulteriore pulizia eliminando anche il file XUL.mfl
(che e sempre nel profilo di Thunderbird).

wn e

A questo punto, Thunderbird dovrebbe essere davvero piu veloce oppure i sintomi di
malfunzionamento riscontrati dovrebbero essere spariti.
Se non dovesse ancora accadere, € perché la compattazione delle cartelle in realta, non
avviene (ce ne accorgiamo perché Thunderbird non impiega alcun tempo a farlo).
La causa e da ricercarsi tra varie prove fatte da noi con le cartelle dell'account, tra gl
allegati contenuti nei messaggi, tra le estensioni installate e disinstallate, eccetera:
Thunderbird non riesce ad eseguire correttamente il comando di compattazione delle
cartelle.
L'ultima prova da fare, pertanto, € molto delicata e complicata, da utilizzare in casi
disperati.

o Fare prima un backup del proprio profilo.

o Aprire Thunderbird.

o Eliminare eventuali cartelle temporanee create e messaggi inutili nelle altre cartelle.

o Chiudere Thunderbird.

o Navigare tra le cartelle del proprio profilo: probabilmente, scoverete una cartella che
rappresenta un vostro account cancellato (non visibile dall'interfaccia di
Thunderbird). Tale cartella ha, solitamente, una dimensione abbastanza rilevante
ed e, probabilmente, nata dalle rimanenze di quando si fanno delle prove passando
da Global account e viceversa.

o Rischiate: eliminate tale cartella.

o Notate se, tra gli allegati della Inbox, ce ne sono di grosse dimensioni.

o Rischiate: eliminate tali allegati.

a Aprire Thunderbird.

o Fate partire la compattazione: a questo punto dovrebbe partire veramente la
compattazione, mettendoci un bel po' di tempo.

o Sicuramente la cartella della Inbox si sara ridotta di dimensioni.

o Ora l'avvio di Thunderbird sara piu veloce e i sintomi di malfunzionamento
riscontrati dovrebbero essere spariti: molto probabilmente il programma ricreera la
cartella dell'account che avevate eliminato.

Commento

Se e installato il supporto “Non in linea”, si puo fare in modo che Thunderbird ci avverta
guando € possibile recuperare una certa quantita di spazio disco mediante I'operazione di
compattazione (“Strumenti - Opzioni - Avanzate - Spazio su disco e non in linea -
Compatta le cartelle solo se si guadagnano piu di.... KB”).
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Messaqgi: cancellati per crash di sistema, con larubrica, come

recuperarli?

Problema

A seguito di un crash di sistema, si sono cancellati — tra i programmi — tutti i messaggi ed
anche la rubrica di Thunderbird. Da un precedente backup, si recupera la cartella profiles,
con un nome simile a questo:

\\Dati applicazioni\Thunderbird\Profiles\default\27krkhsx.slt

con le relative sottocartelle chrome, extensions, mail.

Se si prova a copiare la cartella sopra indicata nella nuova cartella profiles, dopo aver
reinstallato Thunderbird, non funziona nulla: si puo fare qualcosa?

Soluzione

Si, e difficile, ma forse almeno i messaggi e la rubrica sono recuperabili.

Prima di procedere, per non impazzire inutilmente, bisogna ricordarsi che occorre
cambiare, tra le proprieta di tutte le cartelle salvate, 'attributo di “Sola lettura”,
deselezionando la relativa casella!

Molto probabilmente il profilo che si &€ recuperato e corrotto:

converrebbe sempre creare un nuovo profilo.

Poi conviene importare solo le e-mail (leggere I'apposita FAQ), e la rubrica (ha estensione
*.mab).

Dovrebbe funzionare tutto, altrimenti occorre provare a rinominare quel percorso in
questo:

\\Dati applicazioni\Thunderbird\Profiles\27krkhsx.default

e guardare se funziona.

Commento

E buona norma fare sempre una copia di backup del Profilo e soprattutto del file Inbox.
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Messaqqgi: cancellati per errore, come recuperarli?

Problema

Si & svuotato il Cestino cancellando, per errore, della posta utile. E possibile recuperarla?
Cancellando il file “inbox.msf”, come primo suggerimento, purtroppo non succede nulla!

Soluzione

Prima di procedere, fare sempre una copia di backup del Profilo e soprattutto del file
Inbox.

Questo procedimento, pero, non funziona se dopo la cancellazione della posta si e
utilizzato anche il comando per compattare le cartelle; in questo caso la posta eliminata &
stata cancellata irrimediabilmente.

1. Chiudere Thunderbird.

2. Andare nella cartella del Profilo, poi nella cartella Mail e poi dentro quella dell'account
Su cui e successo il "fattaccio”.

3. Si trova un file che si chiama "Inbox" (senza estensione).

4. Aprilo con un editor di testo: si dovrebbero vedere tutte le mail che si sono cancellate.
Al punto 4 di questa FAQ potrebbe presentarsi un problema: il file Inbox potrebbe essere
di tanti MB e, pertanto, potrebbe risultare praticamente impossibile aprire.

Le soluzioni sono due:

- aprirlo con un editor di testi che accedono anche ai file di grandi dimensioni con poco
spreco di memoria e ad una velocita accettabile (ad esempio, uno di questi, open source,
e ScITE: http://www.scintilla.org );

- creare uno script in perl, per accedervi senza neppure aprire il file (soluzione per gli
utenti piu avanzati).

5. Cercare il messaggio che si vuole ripristinare. Dato che il file "Inbox" puo essere anche
molto esteso, questa operazione pud non essere cosi agevole. Se si ricorda I'Oggetto
della mail, o il nome del mittente, si puo utilizzare la funzione di ricerca dell'editor di testo
per agevolare la ricerca. Inoltre, i messaggi cancellati si trovano alla fine del file, sono,
cioé, i primi partendo dal fondo.

6. Trovato il messaggio, si noteranno delle stringhe di intestazione del tipo:

From - Mon Jun 13 21:31:25 2005

X-Account-Key: account2

X-UIDL: bee242b52b451ab50a5aa23f242b0efb

X-Mozilla-Status: 0009 (I'ultima cifra € quella importante nella serie, essa € un numero
variabile: il numero 9, che identifica il messaggio come "cancellato™)

7. Per ripristinare il messaggio é sufficiente cambiare:

X-Mozilla-Status: 0000 (il numero 0 fara si che il messaggio ricomparira, marcato
come non letto.)

8. Salvare e chiudere il tutto, poi riavviare Thunderbird.
9. Alla riapertura di Thunderbird, sull'account "incriminato" apparira tutta la posta che era
stata cancellata, integra e nuovamente a disposizione dell'utente.
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Commento

Un’interessante soluzione per il recupero della posta e degli allegati cancellati si ottiene
installando il browser Opera 8.02 e la sua funzione di importazione diretta delle mail dagli
account di Thunderbird, purché non sia stata eseguita alcuna compattazione delle cartelle.
Le schermate di questo procedimento, comunque, sono disponibili qui:
http://forum.mozillaitalia.org/viewtopic.php?t=12709&start=0&postdays=0&postorder=asc&

highlight=thunderbird+opera

1.

abhwdN

~N O

Installate Opera 8 (http://www.opera.com/ , attenzione perché le versioni precedenti non
vanno bene).

. Recatevi sul menu “File” e selezionate “Importa ed esporta”.

. Selezionate “Importa posta”.

. Nella schermata di opzione, scegliere di importare da Thunderbird.

. Scegliere I'account da importare (eventualmente puntare manualmente alla cartella con

I'apposito tasto in basso).

. Attendere che termini l'importazione.
. Vi ritroverete cosi anche TUTTI i vostri vecchi messaggi cestinati che potrete cosi

consultare o esportare nuovamente.

Grazie a fabrixx, a klades ed a lucasali per questa FAQ.
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Messaqqgi: criptati o firmati, come funzionano?

Problema

Come e perché utilizzare la criptografia o la firma digitale o nelle nostre e-mail?

Soluzione

La criptografia viene usata se il contenuto delle e-mail € particolarmente personale,
onde evitare che malintenzionati possano intercettare la nostra e-mail e leggerne il
contenuto.

Se avete domande specifiche sulla criptografia e su questa tecnologia, questo non € |l
posto giusto per soddisfarle; rivolgetevi piuttosto al newsgroup
it.comp.sicurezza.criptografia o a qualche forum che tratta I'argomento specifico.

La firma digitale, invece, serve per certificare che la mail sia veramente
mandata da noi.

Bisogna infatti sapere che chiunque, con un minimo di conoscenza,
informatica pud mandare una mail col nostro indirizzo.

Per utilizzare questa tecnologia con Thunderbird (0 SeaMonkey) ci sono due strade:
1) utilizzare Enigmail e GnuPG;
2) utilizzare i certificati digitali.

Enigmail e GnuPG

Enigmail € una estensione disponibile sia per Thunderbird sia per SeaMonkey
che permette di integrare GnuPG col nostro client.

Vi rimandiamo a questo link per scaricare Enigmail.

Qui invece trovate la localizzazione in italiano dell'estensione.

Se il language-pack non e ancora disponibile per la corrente versione di Enigmail
vi consigliamo di tenerla in inglese.

Da guesta pagina invece potete scaricare l'ultima versione di GhuPG compatibile col
VOSstro sistema operativo.

Qui invece trovate una buona guida su come configurare I'estensione.

Infine, questo & un sito interamente dedicato all'estensione.

Sempre consigliando di approfondire la conoscenza dell'argomento sui link citati, ecco
come fare per diventare subito operativi:

1) Scompattare il file .zip contenente GnuPG (ad esempio in “C:\Programmi\GnuPG”

2) Installare Enigmail (ed eventualmente il language pack in italiano)

3) Al riavvio di Thunderbird, “OpenPGP - Preferences - Basic” e impostate nel
campo “GnuPG executable path” il giusto percorso del file “gpg.exe” (ad esempio
“C:\Programmi\GnuPG\gpg.exe”)

4) Ora dovete creare/importare la vostra coppia di chiavi da usare con Enigmail.
“OpenPGP - Key Management”. Da qui potete gestire le vostre chiavi:
importarle, esportarle o crearne di nuove se non ne avete ancora una (“Generate
- New Key Pear”).

Se volete che la firma digitale venga messa in automatico: “Strumenti - Impostazioni
account - Nome account - OpenPGP Security” e configurate come meglio credete,
altrimenti — se volete farlo manualmente — basta che in fase di composizione mail
accediate al menu OpenPGP.
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Questa non vuol essere assolutamente una quida all'uso di Enigmail, solo un “avvio
veloce” per chi ne sa gia qualcosa.

Certificati digitali

La seconda possibilita per firmare/cifrare le nostre e-mail € I'uso dei certificati digitali.
L'uso dei certificati non richiede nessuna estensione ed & implementato di default in quasi
tutti i client di posta in circolazione.

Il problema, pero, risiede nel fatto che avete bisogno di un'autorita che vi dia questo
certificato.

Una volta ottenuto ed importato il certificato in Thunderbird (vedere di seguito) per usarlo
e davvero molto semplice:

basta accedere in fase di composizione e-mail al pulsante “Sicurezza” e scegliere cosa si
vuol fare.

Se si vuole inoltre che le e-mail siano firmate di default basta andare in “Strumenti >
Impostazioni account - Nome account - Sicurezza” e spuntare la voce opportuna dopo
aver selezionato il certificato che volete usare per quell'account.

Certificati digitali: utilizzo delle smart-card di Infocamere per firmare le mail.
Ecco come procedere per utilizzare la smart-card per apporre la firma digitale:
1) installare il lettore di smart card come indicato qui;
2) installare il modulo criptografico. L'installazione e diversa a seconda dei vari sistemi
operativi.

Installare il modulo criptografico nei sistemi operativi Windows

Per sistemi operativi Windows il modulo criptografico & contenuto in OpenCSB.

Il modulo si chiama opensc-pkcs1l.dll e se avete effettuato una installazione standard si
trova in “C:\Programmi\Smart Card Bundle\” .

Installare il modulo criptografico nei sistemi operativi Mac
Per sistemi Macintosh, fare riferimento a questo link.

Installare il modulo criptografico nei sistemi operativi Linux

Su Linux ci sono diverse possibilita: potete scaricare i binari col package manager della
vostra distribuzione, oppure scaricare i file rpom da Internet oppure compilare direttamente
da codice sorgente.

Il nome del modulo da caricare in Thunderbird € openpkcsl1l.so.

Per maggiori informazioni fate riferimento alla home page di OpenSC.

3) Importazione del modulo criptografico in Thunderbird/SeaMonkey
Per importare il modulo criptografico in Thunderbird procedere come segue:

o aprire “Strumenti - Opzioni = Privacy - Sicurezza -> Dispositivi di
Sicurezza”

o (per utenti Seamonkey il percorso é invece: “Modifica > Preferenze ->
Privacy e Sicurezza Certificati > Gestione dispositivi di sicurezza”).

o Viapparira una nuova finestra quindi scegliete "Carica" e cercate il modulo
criptografico che avete installato nel punto 2 (ad esempio, per utenti
Windows caricate il file opensc-pkcs11.dll).

o Per verificare che il caricamento del modulo sia avvenuto senza problemi
chiudete la finestra e accertatevi che appaia in “Mostra Certificati >
Certificati Personali”.
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Nota: il modulo criptografico contenuto in OpenSC funziona attualmente con i seguenti
formati forniti da InfoCamere:1202, 1203, 1400.

Per una lista aggiornata delle carte supportate vi imandiamo alla home page del progetto.
Alcuni tipi di Smart Card non supportano inoltre la firma digitale nelle e-mail, in questo
caso rivolgetevi direttamente a InfoCamere e richiedete un certificato di firma idoneo.

Se avete qualche dubbio a riguardo, segnalaterlo su questo topic.

Certificati gratuiti
Se qualcuno volesse provare questa tecnologia senza spendere nulla, puo registrare un
account su Thawte.
Dopo aver fatto la registrazione, si puo accedere al proprio account su Thawte e richiedere
un certificato compatibile col vostro browser.
Al momento in cui scriviamo, non e previsto un certificato specifico per Mozilla, quindi
richiedete un certificato per Netscape.
Portata a termine la richiesta del certificato, & possibile andare nel "Certificate Manager"
del vostro account su Thawte ed installare il certificato nel vostro browser facendo clic su
"Fetch it".
E' sottointeso che stiate usando un browser Mozilla (Firefox/SeaMonkey).
Se usate SeaMonkey avete finito, in quanto il certificato potra essere tranquillamente
usato per la firma delle vostre mail.
Se, invece, avete la coppia Firefox + Thunderbird, dovete trasportare il certificato da
Firefox a Thunderbird.
Per farlo seguite queste semplici operazioni:
1) su Firefox, andate in “Strumenti > Opzioni - Avanzate - Sicurezza > Mostra
Certificati”;
2) andate sulla scheda "Certificati personali” e selezionate il certificato, quindi fate clic
su "Archivia" e salvatelo da qualche parte;
3) vi consigliamo di salvare il file ".p12" in una memoria rimovibile; nel caso lo salviate
nel disco fisso ricordatevi di cancellarlo alla fine dell'importazione in Thunderbird!
4) meglio addirittura se usate qualche utility di “wipe” che non lascia traccia della sua
presenza nel disco;
5) aprite Thunderbird e andate in “Strumenti = Opzioni = Privacy - Mostra certificati”
e scegliete di importare il file appena salvato.

Commento

Grazie a gialloporpora per questa FAQ.
Speciali ringraziamenti anche a fabrixx, a klades, a Simonetta e in particolar modo ad
Antonino lacono di OpenSignature.
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Messaqaqi: data non visualizzata?

Problema

Thunderbird non fa visualizzare la data dei messaggi arrivati nello stesso giorno in corso,
ma solo I'orario. E possibile visualizzare la data con un’estensione?

Soluzione

Si, I'estensione esiste ed é ConfigDate.
Se non volete installarla, occorre creare un file user.js ed aggiungerli le seguenti righe:

/l Configuring the date - time display

/[ Value Example Date

/10 23:53

/I 1 Friday, 31. December 2003 23:53

/12 31.12.1999 23:53

// 3 1999/12 23:53

Il 4 Fri 23:53
user_pref("mail.ui.display.dateformat.default”, 2);
user_pref("mail.ui.display.dateformat.today", 2);
user_pref("mail.ui.display.dateformat.thisweek", 2);

Commento delle righe da aggiungere al file user.js per maggiore chiarezza:

o al posto del 2 dovete ovviamente mettere il formato data che piu vi piace tra quelli
elencati dopo le due barre //;

o mail.ui.display.dateformat.today =il valore di default € 0, serve per impostare il
formato data odierna;

o mail.ui.display.dateformat.thisweek = il valore di default &€ 2, serve per impostare
il formato data della settimana in corso;

o mail.ui.display.dateformat.default =il valore di default € 2, serve per impostare il
formato data di tutti gli altri casi non elencati.

Vi consigliamo di non metterle nel pref.js solo perché di piu difficile manutenzione, infatti
se avete molti profili, potete ricopiare user.js su tutte le cartelle senza intaccare le
configurazioni gia settate.

Commento

Grazie a lucasali per questa FAQ.
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Messaqqi: errore nell’'invio, cosa significano?

Problema

Anche se questa FAQ riguarda indirettamente Thunderbird: cosa significano quei
messaggi in inglese che si ricevono quando si fallisce la spedizione di una e-mail?

Soluzione

Premessa: su Internet ci sono siti piu aggiornati della seguente tabella, qui fornita solo a
titolo di esempio.

"ACTION: FAILED"
Con questo messaggio il server di posta ti informa che non é riuscito ad inoltrare la mail; Ti
consigliamo di controllare I'indirizzo del destinatario e di inviare nuovamente la spedizione.

"ACTION: DELIVERED"
Il messaggio inviato e stato recapitato a destinazione.

"ACTION: RELAYED"
Il messaggio e stato ritrasmesso.

"BAD DESTINATION MAILBOX ADDRESS"
"USER UNKNOWN"
L'indirizzo di posta al quale stai scrivendo non esiste.

"DELIVERY TIME EXPIRED"
L'indirizzo di destinazione non é riuscito a ricevere il messaggio nonostante i ripetuti
tentativi: Ti consigliamo di controllare I'esattezza del recapito e di riprovare.

"INVALID DOMAIN NAME SYNTAX"
L'indirizzo del destinatario non e stato scritto nella dovuta forma; ti consigliamo di
apportare le correzioni necessarie e di ripetere l'invio.

"MAILBOX FULL"

La casella alla quale stai scrivendo ha raggiunto il limite massimo di capienza consentito e
non € pertanto in grado di ricevere ulteriori messaggi. Attendi qualche tempo e riprova
I'invio.

"MESSAGE TOO BIG"
Il messaggio inviato non e stato accettato dalla casella di destinazione a causa delle
elevate dimensioni.

"OTHER OR UNDEFINED PROTOCOL STATUS"

"OTHER OR UNDEFINED MAIL SYSTEM STATUS"

"OTHER OR UNDEFINED NETWORK OR ROUTING STATUS"

Questi messaggi indicano generalmente un temporaneo problema remoto sulla rete o sul
sistema di posta. Ti consigliamo di riprovare l'invio del messaggio in un secondo tempo.

Pagina 78 di 112



"RELAYING NOT ALLOWED"

E’ generato nel momento in cui, utilizzando nelle impostazioni di invio il Server di Posta di
Libero (0 SMTP), si € connessi con un altro provider. Ti consigliamo pertanto di verificare
ed utilizzare i parametri di posta del provider di cui utilizzi la connessione.

"ROUTING SERVER FAILURE"

Generalmente questo errore si verifica quando il dominio (la parte a destra del simbolo
"@" in un indirizzo) non esiste o € stato inavvertitamente digitato in maniera non corretta
come ad esempio "utente@libeo.it" invece di "utente@libero.it".

Commento

ALTRI ERRORI:

Si e verificato un errore sul server. Account: ‘'wind’, Server: 'localhost',Protocollo: POPS3,
Risposta del server: '-ERR delete disabled’, Porta: 110, Protezione (SSL): No, Errore del
server: 0x800CCC90, Numero di errore: 0x800CCC90.
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Messaqgqgi: firme in HTML con immagine, come inserirle?
Problema

Come inserire le firme in HTML con immagine nei messaggi di Thunderbird?

Soluzione

Se volete creare una firma in solo testo:

1.
2.
3.

4.

Utilizzate un editor testuale come il Blocco Note (Notepad) di Windows o altri simili
per creare la vostra firma.

Salvate il documento come un file di testo (formato .txt).

Aprite Thunderbird e andate sul menu “Strumenti - Impostazioni Account”,
selezionate I'account desiderato, quindi spuntate la casella "Allega questa firma".
Il pulsante "Scegli" sara abilitato, fateci un clic e selezionate il file di testo
precedentemente salvato.

Se invece volete creare una firma in formato HTML con o0 senza un immagine seguite la
seguente procedura:

1. In Thunderbird fate clic su "Scrivi" come se voleste scrivere una malil.

2. Scrivete il contenuto della firma e inserite qualsiasi cosa vogliate, formattazione del
testo, immagini (dal menu "Inserisci > Immagine"), eccetera.

3. Quando la firma e pronta, andate sul menu "Modifica" e fate clic su "Seleziona tutti".

4. Andate sul menu "Inserisci" e fate clic su "HTML".

5. Si aprira una finestra, selezionare tutto il contenuto e copiarlo negli appunti (clic
destro + “Copia”).

6. Aprite il vostro editor testuale preferito (come il Notepad) e incollate quello che
avete copiato negli appunti al punto 5.

7. Salvate il documento dando I'estensione .html e non .txt (ad esempio “firma.html”).

8. In Thunderbird, andate sul menu “Strumenti > Impostazioni Account”, selezionate
I'account desiderato.

9. Spuntate la casella "Allega questa firma".

10.1l pulsante "Scegli" verra abilitato, fateci un clic e selezionate il file .html
precedentemente salvato.

11.Quando la vostra firma apparira nelle vostre e-mail, ci saranno anche due lineette (-
- ) sopra di essa, non le cancellate.

Commento

Grazie a james per questa FAQ.
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o possibile inviare lo stesso

messagqio ad altri?

Problema

Dopo avere gia spedito un messaggio, si vuole rimandarlo ad altri: come si fa?

Soluzione

o Andare sulla cartella Posta inviata (dell’account con cui abbiamo spedito il

O messaggio).

o Selezionare il messaggio e fare clic con il pulsante sinistro: si apre una tendina a
menu, selezionare Modifica come nuovo...

o A guesto punto, si apre il messaggio come era in origine, e potete cosi modificarlo e
rispedirlo.

o Altra possibilita € quella, sempre con la medesima procedura, di selezionare Copia
in e selezionare la cartella Bozze dell'account interessato e copiare li il messaggio
per poi modificarlo.

Commento

In caso di ulteriori dubbi, contattate il Forum di Mozilla Italia oppure inserite la vostra FAQ
in un motore di ricerca.
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. personalizzare larisposta?

Problema

Quando si risponde ad un messaggio, Thunderbird scrive di default: “pinco pallino ha
scritto” dove ovviamente pinco pallino e I'autore del messaggio cui si risponde. Si puo
personalizzare la frase di default con qualche informazione in piu tipo il giorno, l'ora, etc.?

Soluzione

1. Aprire il file user.js
2. Inserire il seguente codice:

Codice:

/I Change the reply header

// 0 - No Reply-Text

/['1-"[Author] wrote:"

// 2 - "On [date] [author] wrote:"

/I 3 - User-defined reply header. Use the prefs below in conjuction with
this:

user_pref("mailnews.reply _header_type", 3);

/l'If you set 3 for the pref above then you may set the following prefs.
user_pref("mailnews.reply_header_authorwrote", "%s ha scritto ");

user_pref("mailnews.reply_header_ondate", "il giorno %s");
user_pref("mailnews.reply_header_separator”," "),
user_pref("mailnews.reply_header_colon", ":");
Commento

Su www.extenzilla.org e disponibile anche un’apposita estensione, molto piu semplice da
gestire: Change Quote & Reply Format.
Grazie a jooliaan per questa FAQ.
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Messagqi: scriverli direttamente dal desktop, come?

Problema

E possibile mettere un'icona sul desktop, in modo da poter scrivere una mail senza aprire
Thunderbird? Con Outlook Express — ad esempio - € possibile farlo, creando un file .eml.

Soluzione

1. Creare un collegamento a Thunderbird sul desktop.

2. Fare clic destro su tale collegamento e scegliere “Proprieta“.

3. Infondo al campo “Destinazione” lasciare uno spazio e aggiungere -compose (il
trattino e importante).
Fare clic su “Applica“ e poi su “Ok".
Se si lancia Thunderbird da quel collegamento (che e possibile rinominare, ad
esempio, come "Nuovo messaggio") si apre la schermata di composizione.

S

Commento

Grazie a fabrixx per questa FAQ.
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Messaqqi: spariti quelli scritti, dove sono finiti?

Problema

Dopo avere scritto un messaggio fuori linea, si preme il tasto Invia ma non si trova piu il
messaggio scritto: dov'e?

Soluzione

Molto probabilmente, sono configurati piu account e si crede che il messaggio andasse a
finire in Posta inviata o in Bozze di quell’account su cui si € scritto il messaggio.
Thunderbird, pero, se fuori linea, mette tutti i messaggi da spedire (utilizzando il tasto
Invia) nella cartella Posta in uscita di Cartelle locali.

Se volete che il messaggio rimanga nell'account di riferimento, dovete usare il pulsante
“Salva“: in questa maniera rimane memorizzato nella cartella Bozze di quell'account.

Commento

In caso di ulteriori dubbi, contattate il Forum di Mozilla Italia oppure inserite la vostra FAQ
in un motore di ricerca.
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Messagqgi: spostarli dopo la loro lettura in automatico, e

pnossibile?

Problema

Si vuole creare una cartella dove compaiono solo i nuovi messaggi non letti e poi, quando
vengono letti, vanno via.

Soluzione

Utilizzare i filtri.
A tale proposito, i metodi sono diversi ma il risultato & identico.

1. Utilizzare i filtri di visualizzazione: invece di "Tutti" (opzione di default) impostare "Da
leggere” ed avrete gia risolto.

2. Oppure: Fare clic su “Posta in arrivo” e deve essere visualizzata la barra delle ricerche.
Poi clic sulla tendina "Mostra" e selezionare "Da leggere".

Poi, sempre in quel menu, fare clic su "Salvare la ricerca come cartella....".
A questo punto, si aprira una finestrella che impostera la regola.

Cosi si creera una cartella con la lente di ingrandimento dove andranno tutti i messaggi
non letti... una volta letti scompariranno da qui e staranno solo su posta in arrivo.

3. Oppure: aprire “File & Nuovo - Ricerche salvate”.

Nella finestra che si apre, dopo aver deciso il nome della cartella ricerca, dove posizionare
la cartella e in quali cartelle deve pescare, impostare cosi la regola: stato - non € - letto.
Funzionera tutto.

Commento

| filtri sono uno strumento molto flessibile di Thunderbird. Riescono a risolvere quasi tutte
le esigenze, ma non sono da utilizzare come anti-spam (per fare questo, c'e I'ottimo filtro
bayesiano incorporato in Thunderbird).
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Messaqggi: spostati per errore, come recuperarli?

Problema

Dopo avere spostato, per errore, alcune directory di Thunderbird, ci accorgiamo che il
programma funziona ma la posta e tutta sparita. E possibile recuperarla?

Soluzione

1. Chiudere Thunderbird.

2. Andare nella cartella del Profilo, poi nella cartella Mail e poi dentro quella dell'account
Su cui é successo il "fattaccio”, oppure (se proprio si &€ pasticciato parecchio con directory
e cartelle...) tramite la funzione “Trova® di Windows cercare il file “Inbox”.

3. Si trova un file che si chiama "Inbox" (senza estensione).

4. Questo file non e da aprire.

5. Questo file € da importare nella cartella “Mail” del profilo che viene utilizzato ora: andare
qui http://nic-nac-project.de/~kaosmos/mboximport.html e scaricare I'estensione
mboximport.xpi.

6. Aprire Thunderbird ed installare I'estensione.

7. Una volta installata, sotto "Strumenti” vi sara una nuova voce "Import mbox", che
consentira l'accesso alla procedura di importazione.Per I'esportazione, bastera fare clic
con il tasto destro sulla cartella o sull'account scelto e poi fare clic su "Esporta”.

Commento

E' noto che Thunderbird, cosi come molti altri programmi di posta, usa il formato mbox per
archiviare le email.

Curiosamente, non e presente in Thunderbird una funzione che consenta di importare o
esportare file di questo formato, cosa che rende a volte un po' problematico lo
spostamento degli account da un computer ad un altro oppure la migrazione (ad esempio)
da Mozilla a Thunderbird.

In realta l'importazione puo essere fatta in modo molto semplice copiando il file mbox che
si vuole importare dentro la cartella "Local Folders" (sta nel profilo) a Thunderbird chiuso;
riavviando il programma il file sara visibile come sottocartella di Cartelle Locali.

Per I'esportazione basta invece copiare i file delle email che sono dentro le cartelle
dell'account.

Questa procedura puo pero a volte risultare un po' complessa, soprattutto per chi ha poca
dimestichezza con il funzionamento interno del programma, perché i file del profilo sono in
una cartella o directory nascosta, la cui posizione cambia a secondo dei sistemi operativi o
anche delle esigenze personali.

L’estensione mboximport consente l'importazione/esportazione dei file di posta mbox in
modo semplice.

Note da tenere presenti:

IMPORTAZIONE

- i file vengono importati in Cartelle Locali, in una sottocartella di nome Mboximport;

- non c'é un controllo reale sul tipo di file importato, quindi fate bene attenzione ad
importare solo file mbox;

- per evitare problemi, € possibile importare solo file senza estensione o con estensione
.mbx;

- se il file mbox non e standard, I'importazione non potra andare a buon fine;
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- i file vengono importati come se fossero tutti di posta ricevuta, viene cioe evidenziato il
mittente e non il destinatario. Se si vuole il destinatario evidenziato, basta spostare/copiare
le mail o l'intera cartella importata nella cartella della posta inviata.

ESPORTAZIONE

- se si sceglie l'intero account, verranno esportati tutti i file contenuti in esso, non solo
guelli delle email, ma anche quelli di sistema (indici, filtri ecc.). | file della posta sono quelli
senza nessuna estensione (ad es. Inbox, Sent);

- 'esportazione non funziona con account e cartelle di tipo IMAP o NEWS;

- in caso di account di grandi dimensioni, I'esportazione puo richiedere qualche tempo.

L'estensione € localizzata in inglese e in italiano. E' stata testata su Linux e su Windows,
ma dovrebbe funzionare anche su altri sistemi operativi.

Grazie a klades per questa FAQ.

Pagina 87 di 112


http://forum.mozillaitalia.org/profile.php?mode=viewprofile&u=761

Non siriesce aricevere la

Problema

Non si riesce a ricevere la posta.

Soluzione

Per prima cosa, verificare che Thunderbird riesca ad accedere ad Internet:

o verificare che la connessione Internet sia funzionante con il browser

o se possibile, riprovare a distanza di tempo per escludere che si tratti di un problema
temporaneo del provider

o se si ha un firewall installato, verificare che Thunderbird abbia i diritti per accedere
ad Internet; la prova piu rapida e disabilitare temporaneamente il firewall.

Come ultima cosa, verificare che le impostazioni dell'account siano corrette: ad esempio,
provare ad eliminare/aggiungere la parte relativa al dominio (@dominio.xx)

Commento

Grazie a flod per questa FAQ.
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Scaricare la posta di tutti gli account contemporaneamente,

come?

Problema

Si vuole scaricare la posta di tutti gli account contemporaneamente.

Soluzione

Ci sono diverse possibilita (tutti questi metodi, funzionano SOLO se sono state
memorizzate le password per la ricezione degli account):

o utilizzare la combinazione da tastiera CTRL+SHIFT+T (oppure la corrispondente
voce di menu in “File = Scarica nuovi messaggi per 2>*)

o utilizzare il menu a discesa del pulsante Controlla Posta (solo per TB 0.9 e
successivi)

o utilizzare un'estensione come Invia E Ricevi (in italiano su www.extenzilla.org )

o facendo clic su "Scarica posta" dopo aver creato una Global Inbox ed aver settato
le Impostazioni server di ogni account in questo modo:

Impostazioni Server

[ ] Usa connessione criptata (S5L)

|:| Usa autenticazione criptata

Controlla nuovi messaggi all'avvio

Controlla nuovi messagagi ogni minut
Scarica automaticamente nuovi messaggi

[ ] preleva soltanto le intestazioni

|:| Lascia | messaggi sul server

Svuota Cestino alluscita

B=

Impostazioni avanzate per l'account

srva_E POP

Quando scaricate la posta pop3 da questo server, potete memorizzare nella
cartella posta in arrivo globale (posta in arrivo di Cartelle Locali), nella cartella
posta in arrivo per questo account, o nella cartella posta in arrivo di un altro
account pop3.

()i Posta in arrivo globale (Cartelle Local):

() 'Posta in arrivo’ per I'account di questo server
(7) Postain arrivo di un altro account.

Durante lo scaricamento della posta scarica anche quella di questo account

| == i ot i Ll Ll i d " T
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Commento

Grazie a flod per questa FAQ.
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Parametri di posta elettronica; quali devo usare?

Problema

Anche se questa FAQ riguarda indirettamente Thunderbird: cosa bisogna mettere alla
richiesta dei parametri indirizzo, POP3 e SMTP?

Soluzione

Premessa: su Internet ci sono siti piu aggiornati della seguente tabella, qui fornita solo a
titolo di esempio.

Parametri posta elettronica piu diffusi

'I.S.P. INDIRIZZO POP3 SMTP
'Alice adsl @alice.it in.alice.it out.alice.it
Alice clubnet @aliceposta.it box.tin.it mail.tin.it

'Aruba @tuodominio pop3.aruba.it smtp.aruba.it

Blu @blu.it popmail.blu.it mail.blu.it
'Email.it @Email.it popmail.email.it smtp.email.it
'Fastweb @fastwebnet.it |pop.fastwebnet.it smtp.fastwebnet.it
'Inwind @inwind.it popmail.inwind.it mail.inwind.it

' Internetlibero

@internetlibero.it

mail.internetlibero.it

smtp.internetlibero.it

ol @iol.it popmail.iol.it mail.iol.it
'Jumpy @jumpy.it pop.jumpy.it mail.jumpy.it

' Kataweb.it @kataweb.it pop.katamail.com smtp.katamail.com
Libero @libero.it popmail.libero.it mail.libero.it

' Lycos @lycos.it pop.lycos.it smtp.lycos.it
‘Mclink @mclink.it mail.mclink.it mail.mclink.it
'Poste.it @poste.it relay.poste.it relay.poste.it
'Supereva @supereva.it mail.supereva.it mail.supereva.it
Tiscali @tiscali.it pop.tiscali.it smtp.tiscali.it
Tin @tin.it pop.tin.it smtp.tin.it
'Virgilio @virgilio.it in.virgilio.it out.virgilio.it

'WinTricks.com

(utilizzatori)

@wintricks.com

Tuo provider di posta abituale (tin, tiscali,
virgilio)

smtp.edisontel.com

Yahoo.com

@yahoo.com

pop.mail.yahoo.com

smtp.mail.yahoo.com

Tabelle dei Server DNS (pagina da cui & tratta la tabella)

TIN

Flashnet

dns.flashnet.it

dnsl.village.tin.it

195.14.96.135

194.247.160.1

dnsca2.tin.it

212.216.172.222

dns2.flashnet.it

194.247.160.8

dnscache2.tin.it

212.216.172.162

Elitel
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dns2.tin.it

194.243.154.51 elitel.it 212.34.224.193
dnscacheL.tin.it 212.216.172.62  |ns.elitel.it 212.34.224.132
dnsca.tin.it 212.216.112.112  |ns2.elitel.it 217.146.65.7
dnscatin.it 195.31.190.31 ns3.elitel.it 217.146.65.80
dns. tin.it 194.243.154.62 Tiscali
212.48.4.15 ns.tiscali.it 195.130.224.18
Interbusiness sns.tiscali.it 195.130.225.129
r-dns.interbusiness. it 151.99.125.1 213.305.32.70
dns2.interbusiness.it 151.99.125.3 213.205.36.70
dns.interbusiness.it 151.99.125.2 Atlanet
Iserver—b.cs.interbusiness.it 151.99.250.2 nsi.atlanet.it 213.234.128.211
Libero ns2.atlanet.it 213.234.132.130
ns2.libero.it 193.70.192.100  |nsl.its.it 151.92.2.35
'nsl_ubero_it 195.210.91.100 ns.telexis.it 213.199.1.132
ens-a.libero.it 193.70.192.25 McLink
cns-b.libero.it 193.70.152.25 dns. melink.it 195.110.128.1
Wind
dns.wind.it 212.245.255.2
dns2.wind.it 212.245.158.66
dns.inwind.it 212.141.53.123
dns2.wind.it 212.245.158.66
Caltanet

192.106.1.1

195.210.91.104

DNS pubblici

dns.nic.it

193.205.245.5

dns2.nic.it

193.205.245.8

nameserver.cnr.it

194.119.192.34

Commento

Grazie a Wintricks per questa FAQ.
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SMTP diversi;: come inviare le e mail?

Problema

Generalmente, quando si hanno diversi account, per la ricezione non si hanno problemi: i
problemi nascono quando si cerca di inviare...

Ogni account, infatti, ha un SMTP diverso e non si riesce a "legare" 'SMTP con l'account,
poiché Thunderbird cerca di inviare tutto con I'account predefinito e cosi non funziona
nulla...

Soluzione

Per prima cosa occorre inserire I'elenco degli SMTP andando su

1. "Strumenti" / "Impostazioni account"

2. scorrere I'elenco degli account fino alla voce "Server in uscita (SMTP)"

3. andare su "Avanzate"

4. fare clic sul tasto "Aggiungi..."

5. inserire il server SMTP desiderato

6. dopodiché, sempre nella stessa finestra “"Impostazioni account” scegliere I'account
desiderato

7. scegliere il server in uscita (SMTP)

8. ripetere l'operazione dal punto 6. per tutti gli account desiderati.

Commento

Questo problema non dovrebbe presentarsi spesso, poiché con I'SMTP predefinito
dovreste inviare le mail con tutti gli account; naturalmente occorre impostare quello del
provider con cui vi connettete.
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« PASSWORD

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ sulle password.
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Password: cambiarla, come fare?

Problema

Si vuole cambiare o accedere ad una password memorizzata per un account.

SOlUZIONe
Andare nel menu “Strumenti - Opzioni“ (o “Modifica > Preferenze*), entrare nel pannello
“Avanzate”, nella sezione “Password" e fare clic sul pulsante “Gestione Password

Memorizzate".

o Andare nel menu “Strumenti = Impostazioni account... “, selezionare un account e
fare clic sulla voce “Sicurezza“ sulla sinistra.

o Fare clic su “Gestisci Dispositivi di Sicurezza... “,

o Selezionare “Dispositivo software di sicurezza“ dalla lista.

o Infine, fare clic su “Cambia password®.

Commento

In caso di ulteriori dubbi, contattate il Forum di Mozilla Italia oppure inserite la vostra FAQ
in un motore di ricerca.
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Password: cancellare quella memorizzata per un account,

come?
Problema

Si vuole cancellare una password memorizzata per un account.

SOIUZION e e
Andare nel menu Strumenti - Opzioni (o Modifica > Preferenze), entrare nel pannello
Avanzate, nella sezione Password e fare clic sul pulsante Gestione Password

Memorizzate.
Nella finestra visualizzata é possibile:

o mostrare in chiaro le password memorizzate
o rimuovere alcune o tutte le password memorizzate usando i pulsanti Rimuovi e
Rimuovi Tutte

Commento

Grazie a flod per questa FAQ.
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Password: cancellarne dalla cache una vecchia, dopo il

cambio password IMAP?

Problema

Si é cambiata la propria password IMAP, di conseguenza come si fa ad eliminare una
password presente nella cache?

Soluzione

o Andare nel menu “Strumenti - Opzioni... “, fare clic su “Avanzate*.

o Espandere la sezione “Password® e fare clic su “Gestione password memorizzate*.
o Selezionare la linea sito/username che si vuole eliminare e fare clic su “Rimuovi*.
o Dopo aver fatto cio, fare clic su “Chiudi” e riavviare Mozilla Thunderbird.

Commento

In caso di ulteriori dubbi, contattate il Forum di Mozilla Italia oppure inserite la vostra FAQ
in un motore di ricerca.
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Password: viene richiesta per I'invio della posta, perché?

Problema

Si riesce a ricevere la posta, mentre per l'invio viene richiesta una password.

Soluzione

Per prima cosa, verificare di aver impostato il server SMTP corretto: normalmente, si
utilizza il server SMTP della connessione in uso. Ad esempio: connessione tin.it = server
out.virgilio.it

In questi casi, l'autenticazione al server STMP non € necessaria, e va disabilitata.

Andare in Strumenti (Modifica) - Impostazioni account, selezionare il pannello Server in
uscita (SMTP) e togliere la spunta alla voce Utilizza nome utente e password.

Commento

Grazie a flod per questa FAQ.
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« RUBRICA

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ sulla rubrica.
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Rubrica: si puo aprirla senza aprire Thunderbird?

Problema

Si puo aprire solo la rubrica senza aprire anche Thunderbird?

Soluzione

Si puo fare.

1.

Per prima cosa, bisogna creare un'icona come collegamento al file di
thunderbird.exe (si trova nella directory dove é stato installato Thunderbird,
generalmente C:/Programmi/Mozilla Thunderbird).

2. Una volta creato il collegamento, tagliarlo e poi incollarlo sul desktop.

3. Sull"icona del collegamento che e stato creato, fare clic con il tasto destro del
mouse e selezionare “Proprieta”.

4. Inserire nel campo “Destinazione”, dopo il percorso, la parola " —addressbook",
avendo accortezza di rispettare anche lo spazio e senza virgolette.
(Esempio: si dovrebbe avere C:/Programmi/Mozilla Thunderbird —addressbook .)

5. Conviene poi scegliere un'altra icona per non confondersi con il programma
principale.

Commento

In caso di ulteriori dubbi, contattate il Forum di Mozilla Italia oppure inserite la vostra FAQ
in un motore di ricerca.
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* VARIE

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative a varie FAQ, compresi alcuni “trucchi”.
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Scorciatoie da tastiera: quali sono?

Problema

Quali sono i tasti di scelta rapida per Thunderbird?

Soluzione

Elenco delle pit comuni scorciatoie da tastiera di Mozilla Thunderbird e loro equivalenti in

Microsoft Outlook Express.

Comando

Nuovo messaggio

Apri messaggio (in una nuova finestra)
Chiudi finestra

Stampa

Copia

Taglia

Elimina

Incolla

Seleziona tutto

Annulla

Ripristina

Navigazione tramite cursore
Modifica come nuovo
Espandi tutti gli argomenti
Riduci tutti gli argomenti

Trova di nuovo

Trova il link digitato

Trova precedente

Trova testo in questo messaggio
Inoltra messaggio

Scarica messaggi per questo account
Scarica messaggi per tutti gli account
Vai al messaggio successivo

Vai al prossimo messaggio non letto
Vai al prossimo Thread non letto

Vai al messaggio precedente

Vai al precedente messaggio non letto
Passa al prossimo pannello di posta
Incrementa la dimensione del testo

Mozilla

Thunderbird

CtrI+M
CtrlI+0O
Ctrl+W
Ctrl+P
Ctrl+C
Ctrl+X
Canc
CtrlI+Vv
CtrlI+A
Ctrl+z
Ctri+Y
F7
Ctrl+E

*

\

F3
Ctr+G

Ctrl+Maiuscolo+G
CtrlI+F
Ctrl+L
Ctrl+T
Ctrl+Maiuscolo+T

=
N
T
B
P

F6
Ctrl++

Microsoft Outlook
Express

Ctrl+N
Ctrl+O

Ctrl+P

Ctrl+C

Ctrl+X

Canc

Ctrl+Vv

CtrlI+A

Ctrl+Z

Ctrl+Y

Funzione non disponibile
Funzione non disponibile
Funzione non disponibile
Funzione non disponibile

F3

Funzione non disponibile

Ctrl+F

Ctrl+M

Ctrl+>

Ctrl+U

Ctrl+Maiuscolo+U

Ctrl+<

Funzione non disponibile
Tab
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Mozilla Microsoft Outlook

Comando Thunderbird Express

Decrementa la dimensione del testo Ctrl+-
Ripristina la dimensione del testo Ctrl+0
Etichetta: Niente 0 Funzione non disponibile
Etichetta: Importante 1 Funzione non disponibile
Etichetta: Lavoro 2 Funzione non disponibile
Etichetta: Personale 3 Funzione non disponibile
Etichetta: Agenda 4 Funzione non disponibile
Etichetta: Dopo 5 Funzione non disponibile
Segna messaggio come letto/non letto M Ctrl+Q
Segna Thread come letto R Ctri+T
Segna tutto come letto Ctrl+Maiuscolo+C Ctrl+Maiuscolo+A
Sorgente messaggio Ctrl+U Ctrl+F3
Rispondi al messaggio (solo al mittente) Ctrl+R Ctr+R
::;Ijﬁgggl a tutti nel messaggio (tutti gli Ctrl+Maiuscolo+R Ctrl[+Maiuscolo+R
Salva messaggio come file Ctrl+S
Cerca messaggio Ctrl+Maiuscolo+F Ctrl+Maiuscolo+F

- . Ctrl+Enter
Invia il messaggio ora Ctri+Enter e
Invia il messaggio piu tardi Ctrl+Maiuscolo+Enter
Invia e ricevi tutti i messaggi Ctrl+Maiuscolo+T F5
Stop Esc Esc
Esci Ctrl+Q
Commento

Grazie a David Tenser per questa FAQ.
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Scorciatoie da mouse: quali sono?

Problema

Quali sono le scorciatoie da mouse per Thunderbird?

Soluzione
Comando Scorciatoia

Decrementare la grandezza del testo Ctrl+Scroll Su

Incrementare la grandezza del testo Ctrl+Scroll Giu

Nuovo messaggio formattato (HTML) Ctrl+[Scrivere]

Scroll linea per linea Ctrl+Scroll

Commento

Questa € una lista delle scorciatoie da mouse piti comuni in Thunderbird. Le scorciatoie
sono per la versione per Windows, ma la maggior parte dovrebbe funzionare anche in
qguella per Linux.

Grazie all’autore di questa pagina per questa FAQ.
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* VIRUS

Che cosa troverete in questa sezione

In questa sezione troverete le risposte relative alle FAQ su virus, worm, trojians, spyware,
adware, dialers e tutto quel software maligno, denominato “malware”.
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- qual e il migliore?

Problema

Quale ¢ il migliore antivirus?

Soluzione

Se ci fosse un antivirus migliore degli altri, nessuno si porrebbe questa domanda, in
guanto tutti avrebbero solo quello e gli altri non esisterebbero nemmeno!

Domanda semplicistica a parte, possiamo rilevare come ci siano dei prodotti che — per le
loro caratteristiche — sono pienamente compatibili con Thunderbird ed altri meno.

Non vogliamo fare una classifica a tutti i costi, anche perché il mondo dei software e
talmente in evoluzione che gli stessi antivirus cambiano spesso.

Leggere questo articolo, facilmente comprensibile anche se € in inglese:
http://kb.mozillazine.org/Thunderbird : FAQs : Anti-

virus_Software#Compatible antivirus programs

Commento

Consultare sempre il Forum di Mozilla Italia, a questo riguardo: ci sono tantissime FAQ su
tale argomento.
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Virus: backup dei messagqi infetti cancellati da un antivirus,

come?

Problema

Occorre ripristinare i messaggi della cartella “Posta in arrivo” cancellati da un antivirus
che rileva un messaggio infetto, ma poi cancella I'intera cartella.

Soluzione

- Aprire I'antivirus:
e Se, ripristinato il file inbox dalla quarantena, Thunderbird non riesce a reimportare
le mail:
e Aprire il file inbox recuperato dalla quarantena con un editor di testo
- Aprire Thunderbird:
e Copiare il contenuto (possibilmente salvo la mail infetta) ed incollarlo nel nuovo file
inbox che Thunderbird dovrebbe aver ricreato
¢ Nel caso si sia copiato tutto, non cancellare il virus, eliminare la mail infetta anche
dal cestino e compattare le cartelle
- Altro metodo:
- Installare questa estensione (https://nic-nac-project.de/~kaosmos/mboximport.html)
- Disattivare l'antivirus
- Selezionare “Strumenti - Import Mbox" e scegliere di importare il file che avete
recuperato dalla quarantena
- Dovreste trovarvi le cartelle delle mail in MboxImport, in una sottocartella di nome Inbox
- Se ancora c'é, cancellare la mail infetta
- IMPORTANTE: compattare tutte le cartelle (“File > Compatta Cartelle®): per rimuovere
una e-mail infetta del tutto, dovete non solo cancellarla, ma anche COMPATTARE le
cartelle.
- Riavviare l'antivirus
- Cosi dovreste riavere tutte le vostre mail nella cartella MboxImport, Inbox, poi
spostatele dove vi pare
- Per evitare problemi del genere in futuro, leggere le FAQ che sono indicate qui
(http://forum.mozillaitalia.org/viewtopic.php?t=6820)

Commento

Prevenire € meglio di curare:

"Prevenire € meglio di curare”, quindi prendete qualche precauzione per evitare che
guesto problema ricapiti: la principale e crearvi due nuove cartelle (ad es. "Posta letta
con risposta” e “Posta letta senza risposta”) e prendere l'abitudine di spostare li le e-
mail che volete conservare dopo averle scaricate, in questo modo un eventuale
cancellazione del file inbox da parte dell'antivirus arrechera danni limitati.
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e LINK

Che cosatroverete in questa sezione

In questa sezione troverete i link (collegamenti ipertestuali di connessione ai siti) relativi ai
prodotti Mozilla.

Non e una FAQ che pretende di sostituirsi ad un valido motore di ricerca (& impossibile!),
ma vuole dare una mano all’'utente in cerca di qualcosa di specifico.

E impossibile aggiornare frequentemente questa FAQ (la versione di ThunderFAQ
arriverebbe ben presto alla millesima...), percio alcuni link potrebbero non essere piu validi
(segnalateceli, per piacere).

Una sola raccomandazione: molto spesso, trovate su alcuni (ottimi, per carita) siti i link per
delle nuove versioni dei programmi Mozilla.

Non utilizzate mai tali link per installarvi aggiornamenti o nuovissime versioni!

Nel mondo Mozilla esistono delle versioni di prova (dei “prototipi”, delle “beta”, chiamateli
come volete) che sono sperimentali e che pertanto dovrebbero essere installati solo da
utenti specializzati!

Non abbiate fretta e, a questo riguardo, tenete semplicemente d’occhio il sito ufficiale di
Mozilla Italia (http://www.mozillaitalia.org ): se una versione non appare su questo sito,
non scaricatela da nessun’altra parte!

Mozilla Italia, ovviamente e giustamente, non fornisce assistenza per le versioni
“sperimentali”!
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Link utili

Problema

Dove posso trovare link utili per i prodotti Mozilla?

Soluzione

Ecco alcuni link.

Siti principali (in inglese)
http://www.mozilla.org
Mozilla Update
MozillaZine

Siti principali (in italiano)

Come iniziare

Mozilla Italia (sito ufficiale dell’ Associazione Italiana Supporto e Traduzione Mozilla)
BlogZilla (blog non ufficiale di Mozilla Italia, il gruppo di traduzione italiana di Mozilla)
Il sito di Firefox

Il sito di Thunderbird

Aiuto (supporto)

Forum Mozilla Italia (forum italiano di supporto di Mozilla Italia)
Forum Mozilla Italia sezione Firefox

Forum Mozilla Italia sezione Thunderbird

Forum Mozilla Italia sezione FAQ

Home - MozillaZine Forums (forum inglese di supporto di Mozilla.org)

Download (versioni sempre aggiornate)

Download Firefox in italiano

Download Thunderbird in italiano

Index of /pub/mozilla.org

Index of /pub/mozilla.org/firefox/nightly/latest-trunk-110n
Indice di ftp://ftp.mozilla.org/pub/mozilla.org/firefox/releases/
Mozilla Firefox - Next Generation Browser

Mirror attualmente riconosciuti da Mozilla Italia:

GxWare.org: Public Mozilla Mirror - mozilla.GxWare.net

drudofree.tk | Mirror LangPack in italiano di mozillaitalia.org (link e brevi appunti sulle
distribuzioni Live Linux )

Jooliaan's Mozillaltalia Mirror

http://www.lodolo.it/mirror/

tripleshift Mozilla Mirror

http://www.geocities.com/prometeo uk/langpacks/index.html

Estensioni e Temi

http://portale.extenzilla.org/ (sito italiano di riferimento per temi ed estensioni)
Lista delle estensioni per Firefox (in italiano)

Lista delle estensioni per Thunderbird (in italiano)

Forum Mozilla Italia sezione Estensioni - Temi
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http://www.mozilla.org/
https://addons.mozilla.org/?application=firefox
http://www.mozillazine.org/
http://www.mozilla-europe.org/it/products/firefox/start/central.html
http://www.mozillaitalia.org/
http://www.blogzilla.info/
http://www.mozilla-europe.org/it/products/firefox/
http://www.mozillaitalia.net/thunderbird/
http://forum.mozillaitalia.net/
http://forum.mozillaitalia.net/index.php?board=2.0
http://forum.mozillaitalia.net/index.php?board=3.0
http://forum.mozillaitalia.net/index.php?board=9.0
http://forums.mozillazine.org/index.php?c=4
http://www.mozillaitalia.net/archive/index.php#p2
http://www.mozillaitalia.net/archive/index.php#p3
http://ftp.mozilla.org/pub/mozilla.org/
http://ftp.mozilla.org/pub/mozilla.org/firefox/nightly/latest-trunk-l10n/
ftp://ftp.mozilla.org/pub/mozilla.org/firefox/releases/
http://www.mozilla.org/products/firefox/all.html
http://xoomer.virgilio.it/mozillamirror/
http://drudo.altervista.org/mozilla.php
http://jooliaan.altervista.org/
http://www.lodolo.it/mirror/
http://www.tripleshift.altervista.org/mirror/
http://www.geocities.com/prometeo_uk/langpacks/index.html
http://portale.extenzilla.org/
http://forum.mozillaitalia.org/viewtopic.php?t=3939
http://forum.mozillaitalia.org/viewtopic.php?t=7640
http://forum.mozillaitalia.net/index.php?board=12.0

addons:Mozilla.org (in inglese)
clav's firefox extensions (in inglese)
Extensions Mirror (in inglese)
Extension Room (in inglese)
Kaosmos Website (in italiano)

Guide

Mozilla Firefox: FAQ di Mozilla (in italiano)

Da Internet Explorer a Mozilla Firefox (in italiano)

e-moka Bazar - Navigare con Mozilla Firefox (in italiano)
FireFAQ (in italiano, guida .pdf da scaricare)

Introduzione a Mozilla Firefox (in italiano)

Knowledge Base - MozillaZine Knowledge Base (in inglese)
ThunderFAQ (in italiano, guida .pdf da scaricare)

Mozilla Portatile

Portable MozUp Project (MozUp comprende le versioni su supporti portatili, in italiano, dei
prodotti Mozilla)

Forum Mozilla Italia sezione MozUp

Portable Thunderbird with Enigmail / GPG (in inglese)

Mozilla Stuff (in inglese, il sito del celebre John Haller)

Immagini, sfondi, wallpaper

Forum Mozilla Italia — thread Sfondo Mozilla Firefox
Forum Mozilla Italia — thread Thunderbird Artwork
deviantART: where ART meets application!

Firefox Pictures

Wallpaper - Spread Firefox

xeen » Firefox Wallpaper

Plugin
mozdev.orq - plugindoc: it-IT/index (in italiano)

Segnalazione BUG / Archivio BUG
http://bugzilla.mozilla.org/
http://www.blogzilla.info/?p=301

Vari

Extenzelig (ovvero HuMourzilla, in italiano, per ridere sui personaggi e sui fatti di Mozilla
Italia)

Firefox Furlan (language pack in veneto)

Get Involved - Help spread Firefox! (in inglese)

ilias: Netscape and Mozilla Links (in inglese)

Le 20 FAQ per gli Amministratori ed i Moderatori di Mozilla Italia
MOOX :: Welcome to my Werxshop... (in inglese)

Mozilla Veneto (browser in lingua veneta)

Progetto Firemonger (in italiano)

Rassegna stampa italiana

Ultime novita dal Web sul Mondo Mozilla

Wikipedia — Mozilla Firefox (in italiano)

Wikipedia — Mozilla Thunderbird (in italiano)
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http://extensionroom.mozdev.org/clav/
http://www.extensionsmirror.nl/
http://extensionroom.mozdev.org/
https://nic-nac-project.de/%7Ekaosmos/index.html
http://www.mozillaitalia.org/firefox/faq.html
http://dariosky.altervista.org/firexplorer.php#installazione
http://www.e-moka.net/articoli.php?articolo=4
http://downloads.gxware.org/index.php?dir=pdf/&file=firefaq.pdf
http://opensourcearticles.com/introduction_to_firefox_italian
http://kb.mozillazine.org/Main_Page
http://downloads.gxware.org/index.php?dir=pdf/&file=thunderfaq.pdf
http://www.mozillaitalia.org/mozup/index.php
http://forum.mozillaitalia.net/index.php?board=17.0
http://dev.weavervsworld.com/projects/ptbirdeniggpg/
http://johnhaller.com/jh/mozilla/
http://forum.mozillaitalia.net/index.php?topic=15221.0
http://forum.mozillaitalia.net/index.php?topic=13192.0
http://www.deviantart.com/
http://homeusers.brutele.be/jpbardiau/
http://www.spreadfirefox.com/?q=image/tid/40
http://xeen.navus.org/?page=fxwpwp&lowlimit=0
http://plugindoc.mozdev.org/it-IT/index.html
http://bugzilla.mozilla.org/
http://www.blogzilla.info/?p=301
http://forum.extenzilla.org/viewforum.php?f=15
http://www.spreadfirefox.com/
http://ilias.ca/
http://forum.mozillaitalia.net/index.php?topic=10090.0.
http://www.moox.ws/tech/mozilla/
http://mozillaveneto.sourceforge.net/download-ita.html
http://www.firemonger.org/it/
http://forum.mozillaitalia.net/index.php?topic=5274.0
http://forum.mozillaitalia.net/index.php?topic=3232.0
http://it.wikipedia.org/wiki/Firefox
http://it.wikipedia.org/wiki/Thunderbird

Commento

Grazie a Gioxx per questa FAQ.
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LICENZA D'USO DI THUNDERFAQ

Problema

Posso conoscere le condizioni per utilizzare il presente prodotto?

Soluzione

@creat ive
common

C O M 0O N oH E E Idx

Attribuzione-NonCommerciale-StessaLlicenza 2.0 [talia

Tu sei libero:
o i distribre, comumeare al pubblico, rappresentare o esporre i pubblico Uopera
® i creare opere derivate

Alle seguenti condizioni:

; Attribuzione. Devi nconoscere la

@ patermita dell'opera all'aufore originario.

q Non commerciale. Non puo utilizzare
quest'opera per scop commerciall,
Condividi sotto la stessa licenza. Se
alter, trastormu o svilupp quest’ opera,
puot distribuire I opera nsultante solo per

mezzo di una heenza wdentica a questa.

*  |n occasione di ogm atto di nubithzzamone o distribuzione, devi chianre agh alten 1 termm
della heenza di quest’ opera

e  Seottienn 1] permesso dal titolare del dintto dautore, ¢ possibile nnunciare a ciascuna di
queste condizion.

Le tue utilizzazioni libere e gli altri diritti non sono in nessun modo limitati da quanto sopra.

Commento

Quello di sopra € un riassunto, in linguaggio accessibile per tutti, della Licenza completa,
reperibile qui: http://creativecommons.org/licenses/by/2.0/it/legalcode .

Dati dell'opera:

data di pubblicazione 27 marzo 2006

autori miki64, tittoproject, Underpass

per contattare gli autori mozfag@bigfoot.com

nome del file ThunderFAQ (creato dagli autori)

ringraziamenti a tutti coloro che, con le loro altruistiche risposte, hanno aiutato

in primis gli utenti dei prodotti open-source Mozilla in difficolta, e
poi gli autori a redigere la presente opera.

Gli autori si scusano per eventuali omissioni o errori contenuti nella presente opera,
per i quali non possono essere ritenuti responsabile in alcun modo.
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